


Whether you paint digitally or are looking to expand your
traditional art skills, /magineFX M 7 is the complete

practical guide to creating, and mastering, digital manga

g,
art, Produced in association with / X, the brand-
leading magazine, this book provides you with a unique
insight into the painting skills of artists who create this

[n:'rpu|.il' genre of art.

From basic pencil roughs to first stage line art and

ultimately to stunning finished colour art, /;
brings together the best digital manga and sci-fi art
‘0.':_.\]']-.;\}]['lp_\. 50 i.'.l_l'. | ‘[l\'\' you o0 can }'\l'nllllt_t‘ 1(:||'.| L]l].l].l'l_\'
digital manga characters and scenarios in a variety of colourful,
unique and inventive styles. The simple step-by-step
instructions target specific aspects of manga character
creation, helping you to make your characters lifelike as well
as expertly exploring areas such as help for beginners,
varying manga styles, montage-style posters, rendering
robots and mechanical art as well as comic panels, There are
also important tips on how to create realistic latex designs
and master effects such as pen tools, layering and making
your line art glo

With workshops throughout the book written by
professional digital and traditional artists you are able to get
into the minds of some of the world’s most extraordinary
artistic talent and see them create imaginative and or
artwork. .'\i.h.{ to this \U.llll'lin:_-: manga :_;.IHm'i:w and expert
Q&As and you have the ultimate one-stop resource for

mastering digital manga arr.
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INTRODUCTION

M anga is undoubtedly one of the most popular and mimicked art forms
of modern times. It's success lies in its accessible style, which seems to
galvanize artists around the world to pick up a pencil and start drawing
shapes from simple line drawings through to Et"y-ﬂedged images.

. There are, however, many de%ates surrounding manga. Some argue that
| true manga can only be created by Japanese artists in Japan. Others -
perhaps ill at ease with its popularity — belittle the artwork as being light on
substance. Here, in this book, we proudly celebrate the enguring
international appeal of manga and the way in which it encourages new
generations of artists to put pen to paper and begin creating their own art.

Whether you're just starting out in manga or need to Erush up on your skills, we've brought
together some of the world’s best commercial manga artists and illustrators to share their secrets and
show you how to design characters, paint in a variety of styles and create both stunning illustrations
and comic book pages.

To kick things off we'll show you a handpicked gallery of mouth-watering manga art. Here you'll
find out more about our deleciage cover star Pepper, created by Stanley Lau. What started out as an
exercise in character design for him soon became a global phenomenon. Find out more about
Stanley on page 19. In our beginner’s chapter we'll get you heading on the right path to creating
faces and reveal expert advice on starting out in manga creation. If you're looking to discover your
own style, from page 92 onwards you'll ge inspired by the unique ways you can draw manga. Or,
if you're a fan of sequential art, you won’t want to miss Jamie McKelvie’s masterclass on how to
design the perfect comic page in on page 198.

Throughout this book you'll find ocﬁice, help and insight from professional artists. If you enjoy this
edition, you can also try out the others books available in this series, Fantasy Workshop and Fantasy
Creatures. Happy painting!

Clatre Howlett, Edutor,
rmjmeFK magazine
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GALLERY

CHESTER OCAMPO

LocATioN: Philippines

WEB: www.imaginaryfs.com
EMAIL: chester@imaginaryfs.com
SOFTWARE: Photoshop

Chester says he has been drawing ever since

he was a kid, “taking inspiration from comics,
cartoons, toys and childhood daydreams”. A litile
later, he got engrossed in videogames but comics
remain Chester’s first love. Chester says he's proud
of the fact that he's selftaught, “although part of
me wonders what | could have achieved with
formal art training”. Several years ago he got
acquainted with Photoshop, “but it wasn't until

a few years later that | started making artworks
straight on to the computer, with a pen tablet”.

ARA TWO POINT OH (this page) Originally, this
piece was called The Superfluous Anecdotes of a Post-
Apocalyptic Third World Teenage Drama Queen -
“which pretty much sums up my plans for her in terms
of story and sefting”.

AMBER CRESCENDO (facing page, full bleed) “If war
can be likened to a complex dance, then warriors are,
in essence, deadly dancers.”

OROBOROS (facing page, insel) “Everything evens out
eventually,” says Chester. This piece is “the result of
playing with more binary opposition concepts than |
know what to do with”.
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BAGUS HUTOMO

LOCATION: Indonesia

weB: bagushutomo.blogspot.com
EMAIL: zik_zag04@yahoo.co.uk
SOFTWARE: Photoshop

Bagus has been working as a digital artist for
several years. “My first gig was at an animation
studio in Jakarta, then | worked as a 2D artist at
Infinite Framework, an animation studio in Batam,”
he says. More recently he painted the artwork for
the Radical comic book series Shrapnel: Aristeia
Rising. Bagus got his first taste of science fiction at
college, when he read Akira by Katsuhiro Otomo.
“I'm actually more into cyberpunk, but you can find
several different sorts of concepts and themes in my
work,” he says. Still trying to explore not only his
rendering skills but also concepts in his personal
work, Bagus is fascinated by machines, military
hardware and complex objects. “They're all things
that appear rather frequently in my work.”

EINE HOLLE (THE HELL) “My first mecha work, and also
my first finished work,” says Bagus. “I start by scribbling
out a few rough ideas on paper, then edit it in Photoshop.
Then as soon as | have the image that I'm looking for, | do
a quick colour test to finalise exactly what | want the

finished image to look like.”

W Gallery




LA-CAIDA Another post-war scene: “A fantasy urban city where people
can float.”




GALLERY

~ JOHN STAUB

'LOCATION: USA

‘weB: dustsplat.deviantart.com
‘EMAIL: dustsplat@gmail.com

' SOFTWARE: Photoshop, Painter

“Ever since | was young, I've always been into

:  things that are very visual,” says John. Fantasy art
| was an important example: “I always saw myself
| gefting drawn to those types of images and found
- myself inspired by the creativity and look.” During
high school, John found himself drawing more than
‘ever and, in the process, getting more serious about
his art. He draws mostly manga and animé because
that's what excites him. “I also enjoy creating worlds
that | would personally be drawn to and would
rather be in,” he explains. Digital art is a relatively
new thing fo John - “it’s easier to apply and express
myself, and since the world is now turning digital
| find myself getting more and more inspired to do
these kinds of images”.

| COIN DROP “Imagine a hollow mountain made entirely of
houses built on top of each other. And within that hollow
cavily is a vast city. That's what this image is, in a nutshell.”




' RUSTY GUARD “This image

. is of a female warrior who
has a mechanical guardian

| who carries her sword for
her. She just grabs it from his

arm whenever she needs it.”

ooy HJE




RUNGSAK SONTAYANONT

LocATioN: Thailand At school, Rungsak liked to follow the works of his favourite
weB: digitalome.deviantart.com artists, both on the web and in magazines. “This inspired me
EMAIL: ome_no@hotmail.com to produce my own digital art,” he recalls. And his youthful
SOFTWARE: Photoshop enthusiasm paid off. He's now working as a character and key

lighting designer. “I think my current work is not good enough,”
Rungsak confides. “It still has to be developed to get a good
result in the future.”

GOD'S MUSIC FESTIVAL 3 “The musicians are going to travel in the
human world and then back to their living place,” says Rungsak.
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TAOTIE A demon dragon

is disguised as a human

to devour unlucky souls.
“She has a habit of
eating and collecting
swords. Her bottle can
suck anything in and turn
it into liquor.”




GALLERY

YAGATAMA

LOCATION: Japan

WEB: yagatama.deviantart.com
EMAIL: yagatama@msn.com
SOFTWARE: Photoshop

NO FINAL FOR FANTASY Having watched speedpainting on YouTube,
Yagatama tried to do the same on this pic — “but it took me nearly two
hours just for the background!”
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PSYCHIC FORCE “I intended fo draw a piece of fan art for Biomega,
the Tsutomu Nihei comic,” says Yagatama, “but | changed it into my

own world.”

“Unlike some famous artists around the globe,” says the artist
known as Yagatama, “I only started painting when | was about
20 years old. So | don't have that much experience yet.”
Yagatama was put on to digital art by his teacher, who
suggested digital colour as a better route for the young artist
than acrylics. “I was living in New Zealand then.” Yagatama
chose an art school called Amusement Media Academy because
it was the closest one to where he lives. “I loved watching
movies like Aliens and Ghost in the Shell when | was little. As for
fantasy, | found The Never Ending Story to be very inspiring.”




STANLEY LAU

LOCATION: Singapore
WEB: artgerm.deviantart.com
EMAIL: info@imaginaryfs.com
SOFTWARE: Photoshop

Stanley’s original concept was
an exercise in character design
- a character whose features
never stayed the same but
whose fixed personality should
shine through any change of
appearance. Soon, Pepper
became a phenomenon, people
started to produce their own
version and some even began
cosplaying as the character.
Many thousand images of
Pepper appeared on the net
and the best efforts were put
into a book The Pepper Project.

PEPPER The cult success of Pepper
soon made it clear that she was no
longer Stanley's exclusivity, but had
a life of her own.
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DALLERY

PATIPAT ASAVASENA

~ LocamnoN: Thailand

. wee: asukal 11.deviantart.com
EMAIL: digiemo@gmail.com
'SOFTWARE: Photoshop CS3, Painter X
8 “'m a fan of the famous animation Evangelion,” says Patipat.
“The Ffirst time | walched it, | was stunned!” And when the
‘shock wore off, he started drawing. Participating in online
mmunities, Patipat quickly made friends, exchanging

riiques and pursuing collaborative projects. Eventually,

rough practice, a new, more realistic style began to emerge.
‘And through self-study in art, | still keep learning new things
“every day | can,” he says. After a year working as an art
“director for a local games studio in his native Thailand, Patipat
opted fo work as a freelancer for a while, and is better known
‘as Asukalll.

| PERFUME HARVESTER Patipat was involved with a group of
‘Thai artists on a calendar project. “My theme was Perfume City,”
he explains. “Personally, | love the colour of this piece.”







GALLERY

the couple’. Patipat explored this with the

reed’. The mechanical butterfly wings
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ARTIST PROFILE
SAEJIN OH

| country: Canada
¥ wes: www.saejinoh.deviantart.com

-

Saejin is a freelance illustrator who loves creating
concept art and character designs.

ARTIST INSIGHT

GET UNDER THE
SKIN OF MANGA

Saejin Oh has some invaluable advice that will help you draw and paint better manga

Big eyes, small mouth and fancy hair: this unique style need to know who the character is or where they're from to
originating from Japan boasts immense popularity know you like them. Such emotional connection is difficult to
with its most loyal fans. People love manga for its fantastic achieve with other styles.
imagination, lovable characters and the inspirational quality The effect that manga has on people is easy fo experience.
that can only be defined by the Japanese word ‘moe’. It's almost impossible to go to a convention without seeing
Manga has captivated audiences around the world. someone cosplaying as Yoko or Cloud, while the artists at
There's just something about manga. It could be the big their tables hand out posters of their own big-eyed characters.
puppy-dog eyes or the puffy red cheeks, but it's a visual style The style is undeniably extremely popular, but how can you
that makes an instant connection with its viewers. You don’t draw it effectively?

# Manga for Beginners







A THE EYES HAVE IT

Large, shiny eyes are the defining
characteristic of a manga character. They go
beyond the anatomical capacity of a human
skull. A manga eyeball, if it was real, would
be non-spherical and would crush the brain.
 Yet reality has no place in manga. It's an
aesthetic style, an exercise in the
simplification of the human physique to

accentuate what's considered beautiful.
Manga characters aren’t meant to be real:
they're symbols, like an emoticon or smiley.
But what does it mean to draw one?

‘€% NOT ALL EYES ARE MADE THE SAME

Few people realise that there are two distinctive styles of manga eye, and the
results they achieve are staggeringly different. One is called continuous style, while
the other is noncontinuous style. Continuous style attempts to exaggerate the eye
while obeying the rules of human anatomy; in contrast, non-continuous style
completely disregards reality

Non-continuous style eyes are easily recognisable because the character’s upper
and lower eyelids are detached from one another. The line that runs around the
outside of the eye is therefore disconnected. Both styles have advantages and
disadvantages, and recognising these will enable you to draw more effective
manga-style characters.

¥

€8 PROS AND CONS OF THE STYLES

Continuous style looks relatively realistic, but is still aesthetically pleasing. However,
you need fo know. the structure of the eye before you can draw. this way. And

because you're using relatively realistic proportfions, you cant make the eyes too
large. Size isn’t an issue for non-continuous style because such eyes don't have a
fixed dimension. However, non-continuous slyle is limited to larger eyes and simple
facial rendering - it doesn't fare too well with complex painting and shading.

v Manga for Beginners



Manga characters have simplified facial features, but
even subtle changes in eyebrow height, eye size and
mouth shape affect the entire mood of the piece.
Manga eyes often don’t have much anatomical
detail, so artists use shape and size to show
expressions. You can only change the shape so
much without a muscular structure to support it.
These expressions are so widely used, it's
hard to define manga without them.

‘€% ON THE NOSE

~ Fictional people can’t breathe, so what's a nose to a

" manga character? While reading your faveurite manga,
you've probably wondered why the nose is so simple.
There’s no nasal bridge, no nostrils, no bones ~ just a dot!
It sounds strange if you put it like that, but in manga you
have fo discard unnecessary delails for the sake of
aesthetics. This is @ manga character, not a ZBrush render.

gy When you have so little detail on your character, every

Q‘- CON-”NUOUS Vs NON'CONT’N“O“S position, line and dot is crucial. You can, however, add a

.. realistic nose if you know how to stay within the siyle.

The battle still rages on here. A dot nose is the prime example of a non-continuous

style, in that it has no anatomical connection as we've previously described.

The nose is broken off from rest of the facial features and is essentially hovering

over the centre of the face, connected only by a colour that resembles flesh.

If's @ strange way of dealing with reduced details, but it works. If a character

looks great with a dot nose, it's difficult to argue with that.

The continuous style, however, adopls the more sublle approach of discarding
only the worst-offending details. This style attempts to use nasal bridges and
other elements as much as possible, without becoming overly complicated. This style
also works brillianfly but, again, it requires a better understanding of anatomy.

It's important to avoid mixing elements, such as continuous style eyes with a non-
continuous shyle nose, and vice versa. You can try it, but you must remind yourself that
you're mixing flat 2D style with a full 3D style. It may work in the end, but you might
find that you've sacrificed one of the styles without even noticing it.



6% MAKING MOUTHS

Manga has little to say about the mouth, although it's one of the core
details of a manga style face, along with the eyes and nose. A manga
mouth is usually nothing more than a single line without any indication
of lips, tongue or teeth. It works brilliantly, of course, thanks to the
simplified style that goes along with it.

‘G4 LIP SERVICE T
When it comes to lips; all thal’s required to draw an older character is a Z
single line by the mouth. Depending on how they're drawn, lips can turn an
innocent character into a mature onee-san (big sister).

Realistic lips are the bane of manga characters’ existence. They're simply
not made for each other. Manga deals,with the problem by treating the whole
mouth area as a flat surface. Interestingly, bath continuous and non-continuous
styles treat the area in a rather simplistic manner; and even a small detail will

stick out like a sore thumb. The lips are usually eliminated to harmenise the
facial features but, if the character has more dynamic face contours, then

bulging lips won't be @ problem.

& | AM WOMAN

The manga style is used almost exclusively
for androgynous male characters, female
characters and children. A man drawn in
manga style is just a man. There may be a
degree of androgyny in the male character,
but you wouldn't notice if someone ported
Kratos over o Bleach and gave him some
celshaded colours, At its hearf, manga is
an art style for female characters or any
character that resembles a female. The
males are left with a relatively realistic style
that's indistinguishable from reality, apart
from cel-shaded colours.

L
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" The manga style is easy to break ~ you must know precisely where

~ your character's eyes, nose and mouth are. However, maintaining

~ consistency becomes difficult as you progress with your character.

~ No doubt you'll soon need to present a range of emotions as you

. depict them reacting fo a certain situation.

~ There is a straightforward solution, however. You can have a
replacement model - a different version of the same character for

~ expressing exireme facial expressions. This frees you from the
responsibilities of keeping your character consistent, and also allows
' for a greater range and depth of behaviours. There are often different
versions of manga characters for certain situations. A serious character,
~ for example, may have a non-continuous style version for comedic
~scenes, That way, the character can express different emotions while

iy

¥ LET'S FACE FACTS

Manga characters are fragile and tend to change with the slightest
modification. Here, you can see just how drastically a slight change
can influence the way a character is perceived.

. One of the most important factors defermining personality in manga
is the relative location of the eyes, nose and mouth on the face. The
effect is subtle, but the changes are significant. Unlike western cartoon
styles, where characters’ features are constantly changed by siretch-and-
squash methods, manga has very little tolerance for dynamics. This
factor is key in keeping characlers consistent.

Manga for Beginners w



4@ LISTEN UP ——

The neck is important because it connects two different
worlds: the face, which is in the realm of manga, and

the body, which falls info the realm of reality. It's up to

the neck to create harmony between two ways of thinking.
As such, it must never be too simple or too real, too thick
or too thin. It needs to strike a balance.

You have more freedom with the character’s ears. These
can often be neglected in favour of more important details,
but you can also draw them realistically without affecting
your manga character in a significant way, provided you
paint or shade them in the same way as the rest of the piece. Sy —— .

ﬁf* A FATAL FLAW

Manga is a style of specific viewpoints. Front, side, three-quarter and
the intermediate angles all work, but there are a few perspectives that
the style can't handle on its own, The prime example here is the bottom-
up view, where the face disappears and the jaw bone determines the
facial contours. Manga was never designed with jaw benes or jaw
lines in mind and has no answer for this shoricoming, so the arfist is
forced to bring the character back into the realm of reality. There is,
however, a western approach that ireats the entire head as a solid

shape. This works better for non-continuous style manga. .
@ THE END RESLLT

So our journey into the world of manga has finally come to an end.
We've learned so much here — not only how to draw spheres here and
there fo recreate something that resembles a manga character, but why
those manga characters are fundamentally the way they are.

Manga style is very simple to draw. There are thousands of aspiring
manga artists who start their drawings with big eyes and a small nose,
but as we've learned in this workshop, there's more fo it than that. The
style is easy to pick up, but hard fo master.

You need o be able to draw something in detail before you can
condense it. Manga may. be tempting as a quick way into the world of
art, but you'll still need to understand human anatomy before you can

simplify it. How else will you know if you're doing it right?

v Manga for Beginners




ARTIST O:A 1

LeFT: Keep the facial features
simple and clean to achieve
the perfect manga siyle.

oo v o vee o0t FMate e
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SAEJIN OH REPLIES
L
The way that characters look and feel o2
‘manga’ is all in the simplification and 2%
exaggeration of their facial features. 5 '
However, that doesn’t mean the style is loose or ore®
unstructured: it's actually quite the opposite, and I
requires you to nail down exact positions for each og%®
line you draw. Here are a few pointers. ot
First, minimise the complicated structures of the nose  s®s®a%
3 : OO
and lips, and reduce the size of the sidewall of the nose  [*s
as much as possible. The nasal bridge must be shallow ~ ®
or flat. Remove the upper lip and either simplify or %
subtly indicate the bottom lip with a simple shadow. ®
Exaggerate the eyes. They don’t have to be large,
but you do want to make them aesthetically pleasing.
Minimise the white of the eye while exaggerating

the pupil.

Finally, make the head a bit larger than a real
person’s in relation to the character’s shoulders. This
is especially true for drawing female characters. You
should also completely remove subtle features such
as facial grooves and wrinkles. Manga is all about
replicating youthfulness in the character.

The only thing that really separates manga and __
more realistic styles is their facial features. Beyond that, 4

4 \mongu characters can be quite realistic. /

B oekting oy e Fociol feckures you
~ didn't plan in the first place. Rough

skin textures are a big no-no.

.
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JOANNA ZHOU

| country: UK
CLENTS: Animexx eV, Raptor Publishing
weB: www.chocolatepixels.com

Joanna is a freelance illustrator and graphic designer.
She has 10 years’ experience drawing manga with
professional exposure in the UK, USA, Austria and
Germany. She is also a member of the well-known
UK manga group Sweatdrop Studios.

ARTIST INSIGHT

ESSENTIAL
MANGA TIPS

Joanna Zhou reveals 26 gems of wisdom for creating art that’s unmistakably manga

Wiihoui a doubt, manga is one of the fastest growing who say that manga is a useless hobby. Any form of visual
art forms among young people across the globe. Most creativity is infinitely more productive and satisfying than
artists discover this hobby in their teens and face the challenge many other pastimes that spring to mind.
of self-directed learning alongside school or university. Despite its stylisation, manga techniques incorporate

I've never seen manga as work, but a fun refuge from perspective, solid proportion and colour theory, which benefit
the actual stresses of daily life. | hope that other aspiring a huge variety of careers or life situations. Hopefully the tips
mangakas (manga artists) will see it in the same light, I'm going to give you over the coming pages will inspire and
because with this attitude, arfistic improvement will become encourage you to delve deeper info the fascinating world of
an enjoyable and effortless process. Don't listen to people Japanese comic art.

w Manga for Beginners







4 LEARNING FIGLRATIVE
PROPORTIONS

In manga style, the human body is offen used metaphorically to express
dramatic or comedic impact. Take a look at any manga comic and
you'll find a figurative fluctuation between body shapes ~ even of the
same character between one image and the next. Mastering each
proportion greatly enhances your flexibility as a visual storyteller. You
may even end up adopting a certain body type as your signature style.

€% SUPER DEFORMED STYLE ~ ~

When drawing chibis (in manga, a chibi is basically a cute, small,

childlike version of an animé or manga character), you should
constantly remind yourself to keep the torso, arms and legs as short
as possible [erasing any excess if necessary), Because our sense of
regular anatomy is so deeply ingrained, it's all too easy to make the
limbs longer than they need 1o be, resulfing in a child rather than a
chibi! Bright or pastel colours are well suited for chibis because they
enhance the dynamism and cuteness of each character.

€¥ CGLUIDELINES ARE VITAL

Use guidelines wherever possible! They only take a second to draw
and can drastically reduce the amount of unnecessary mistakes, such
as eyes not being level or hair not following the shape of the head.
‘Ball joint" bodies enable you to see at a glance if cerfain limbs are the
same length. Guidelines can also be used to denote the ‘twist’ of a
body posture in a dynamic scene.

‘& FROM ROLGH TO DETAIL

Always work roughly to begin with and gradually build up the level you've already identified it, even if it entails a lot of redrawing.
of detail in your image [see the three rough sketches at the top of the Guidelines and rough sketches promote maximum efficiency and
page). If you start adding intricate sparkles to an eye before even accuracy when drawing. They also force you to think carefully
completing the face, you may discover later that the whole eye is in about the technical composition, which has to be good.

the wrong location and needs to be erased. Never leave a mistake if

W Manga for Beginners




‘#% DESIGN MEMORABLE

- CHARACTERS

- One of the most unnecessary mistakes in comic drawing is fo lose your
- readers’ interest because they can't tell your characters apart. Each

- character should have significant differences in hair, eyes, height and

~ clothing (unless the storyline dictates otherwise, of course). Consider

~ how colours, hairstyles and accessories can be used appropriately to

represent certain persondlity traits. Also, adding background, props or
narrative creates a stronger context for your character.

‘4 DIFFERENTIATION (ISN'T JUST
A HORRBLE THING IN MATHS)

A more advanced technique for varying your characters is fo draw

different eye shapes and facial outlines for each one. This requires

some practice but if done correctly and consistently, it becomes a subtle
~ yet very effective way of differentiating characters.

‘€ 360 DEGREES

As you praclise, remember to draw the head from different angles.
Don't fall info a rut of always drawing the same tilted head facing the
same direction. A full-frontal face is actually quite challenging because
you have to make sure that both eyes are absolutely identical. If you
hope to take your manga drawing further, one of the first things
publishers look out for is the ability to draw the same face from

many perspeclives.
Manga for Beginners v



"€ CREATE ORDER
USING CHAOS -

Exciting manga hairstyles have thick and
thin strands arranged in a seemingly
random manner, yet still form a pleasant
shape as a whole. The same principle
applies towards clothing folds. Practice
drawing ‘randomly’ but with enough critical
judgement so it doesn't become a mess.
Hint: curved lines look best when they're
drawn in one single sweep. Holding your
breath could make your hand momentarily
steadier! Try it...

¥ THE SECRET OF ELEGANT
LINE ART

Always vary your line width when inking te create an appealing,
dynamic image. Use thicker lines to emphasis contours (such as the
face shape) and thinner lines to suggest distance (billowing hair
strands), Having the same line width everywhere creates a static and
slightly sloppy effect. Manga art is traditionally inked using a nib pen
[as seen on the image right). Fineliners and digital inking are viable
alternatives, as long as you take care to alter the line weight.

€ HOW DO | DRAW HANDS?

As with the human body, you have to be thoroughly familiar with their
physical structure before being able o create poses from scratch. Study
and draw your own hand fo understand digit length, how they bend
and which fingers tend to group together in certain positions. Manga
hands place emphasis on grace, so detailed nails and wrinkly knuckles
are usually blended out.

w Manga for Beginners

“&F BE CONFIDENT WITH
YOUR MARK-MAKING

A good piece of advice I've had is to turn my
scruffy pencil sketches into a single beautiful line.
A single line in the right place can project beauty
and power, whereas a mass of scratchy oullines
only reflects hesitance. With rare stylistic
exceplions, manga drawings should always
contain crisp, confident contours.

& QUALITY OVER CONVENIENCE

Sometimes it's templing to sit.and fidget over an image instead of
getting up to look for references. But at the end of the day, you've
wasted more fime trying to fix it yourself — and chances are it still looks

worse. It only takes a second to take a phetograph of your own hand
or yourself wearing a certain garment with clothing folds. You will learn
much more by copying correctly than by free-styling incorrectly.




¥ IN YOUR FACE!

The face is where you can make or break an

¥ THROUGH THE
. LOOKING GLASS

Holding your drawing up to a mirror is an

emotional connection with the viewer. The
face is a good place to express style. Maybe
effective way of spotting mistakes. The results you have a certain way of drawing eyes or
are often quite sobering ~ what looked mouths that will eventually become your
trademark. Think about how the mouth, eyes,
pupil size and eyebrow position express a

certain emotion. If in doubt, look atyourself

perfect during skefching could have hideously
asymmetrical eyes and other anatomical
mistakes. Keep correcting the image unfil you
are happy with the reflection. in the mirror and notice which areas of your
face move. Practice making as many
expressions as you can — just make sure no

" one’s watching...
‘& THE PROFILE

Manga profiles are usually bottom-heavy with the nose and mouth jutting further outwards.
Practice drawing an eye from the side and remember fo position it in line with the ears
and the ‘dip’ between nose and forehead. Males have a more pronounced and angular
jaw line than females, Body proportion will also affect the profile of face, hair and eyes.

Drawing the bald head first ensures the correct placement of hair.

{f¥ FEMALE BODIES

8

. Manga female body proportions are usually ;
. very pelite, reflecting the beauty ideal of o L

 Japanese women: Depicting defined muscles ﬁ sp EED UP
~or an Amazonian build is less aesthetic, and ;

- definitely less mainsiream. It's common, YO“R PROGRESS
~ however, to add voluptuous breasts in order

1o differentiate women from girls. The fastest road to improvement

is fo know your own strengths and

o

. ‘;.‘;‘: 1) weaknesses, through crifical self-
. \ﬂ‘: Bu FF BISHONEN.’ analysis and the constructive

opinions of others. Create a clear

Male bodies fluctuate between heavily mental plan of areas you need to

muscled forms and an almost androgynous tackle, as well as areas in which

beauty. Ironically, the latter is more popular you do well and can develop fo

with female artists. Bishonen (beautiful boy] your advantage. Doing something simple well is more morale-boosting than

style simplifies the male body into a slender always aiming (and failing) at unrealistically difficult tasks. Bright bubbly colours and
form, with graceful indications of muscle and chibi characters can deftly hide the fact that an image (see the various postcard

a notable lack of nipples or body hair. images above) does not involve advanced knowledge of proportion or perspective.
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¥ THE JOY AND AGONY
OF CLOTHING FOLPS o

Copying from fashion magazines is a great way of training your eye fo
differentiate visually important folds from insignificant crumples. You'll
get an inherent understanding of how different garments drape over the

body, which is a vital foundation for designing your own clothes using
a variety of fabrics and cuts. When in doubt, it's better to have a few
simplistic lines indicating folds rather than a jumbled mass of incorrect
zig-zags just for the sake of detail.

& DRAWING OLD PEOPLE

The standard manga face is poorly suited to adding wrinkles. In order
to create a realistic older person, you have to alter the entfire facial
oulline to correspond with the sagging and wrinkling that occurs with
the ageing process. The eyes become smaller and the distance fo the
mouth increases.

€ COMIC CONVENTIONS
(NOT THE SMELLY ONES)

There are many rules and icons specific to manga style when it comes to
expressing certain moods or situations. For example, speed lines can be
used literally for movement or figuratively for emotional shock. Study
various mangas to identify these narrative devices and fry to incorporate
them into your own werk. Manga page layouts are a lot more dynamic
than the box panelling of many western comics. However, take care not
to let a complicated layout hinder the reading flow.

# Manga for Beginners




€ THINK BIG,
BUT DRAW SMALL

Thumbnails provide a vital overview of your
page and enable fast editing of various
elements (panel shape, speech bubbles and
so on). Not only is this much more efficient
than making large-scale corrections, it also
ensures that your final comic sheet is subject
to far less erasing and redrawing, which
could affect the final image quality. Your
thumbnails can be as rough or as detailed as
you feel is appropriate. But they must show
the panel arrangement, speech bubble
location and character shots.

‘& WORK IS PLAY

The only way to improve is to practice, and
you can only practice a lot if you enjoy it.
Drawing is a therapeutic hobby, and you
should do whatever makes you feel good. If
you only draw to beat others, then you'll end
up frustrated if success doesn’t come.

@ NARRATE, AMUSE
AND ENTERTAIN!

Manga style isn't always about creating a
glossy-eyed pin-up. Try using character
interaction to create a dynamic snapshot with
one or many punch lines. This works well
with chibi style but can also be done with
regular proportions for a darker narrative.
Imagine yourself as a manga journalist, not a
fashion photographer, The more detail and
narration, the longer someone will want to
look at your image... and that can only be a
good thing!

‘€3 RULE-BREAKING

There are rules to manga, but you're not
obliged to follow them. In manga style,
creativity is often forgotten in the drive to
draw things realistically or learning to colour

like a certain artist.

& DO YOUR OWN THING

Experiment with media and fechniques to challenge
the stereotype of what people imagine manga can
be. This image is a Photoshop collage of a soft pastel
background and two manga characters. The effect is
entirely unlike the slick CG effect that you might

usually associate with manga illustration,
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N\, ARTIST 06

Let's start by doing a rough drawing -

you know, the usual. Start with simple

structures: head, neck, chest and limbs in
rough cylindrical forms. Next, create another layer on
top, fill it with white, change the Opacity so that your
rough lines faintly show through, then merge the layers.
Alternatively, you can use brute force - as | do - by
enlarging your brush and lightly painting over your
lines with white.

Now you can draw in more detail, such as clothing
and hair, repeating the process above to clarify your
line art bit by bit.

Once you have a rough drawing that's closest to
your final line art, you can fade out your line for the
last fime.

When you start your final line art, try hard not fo
break the lines, and keep them continuous. If you draw
the line too long, erase the end where it sticks out.

Curvature, too, is something you just have fo get
right in order for your pictures to look decent, so use
the Undo function liberally until you do. Remember,
persistence is required for a good result. It will take
some effort the first time around but, if you practise,
then you'll be able to do a masterpiece in no time!

A

v Artist
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Use a smaller, thinner brush to paint the lines manually. Try fo keep them clean,
and use Undo liberally when necessary. Repeat until done.

Once you have the rough lines,
enlarge your brush and paint over
them with white to fade them out.

| 4 | .
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ARTIST PROFILE
JOANNA ZHOU

COUNTRY: UK
CLIENTS: Animexx eV, Raptor Publishing
WwEB: www.chocolatepixels.com

Joanna is a freelance illustrator and graphic designer.
She has 10 years’ experience drawing manga with
professional exposure in the UK, US A, Austria and
Germany. She is also a member of the wellknown UK
manga group Sweatdrop Studios.

THE CHERRY
BLOSSOM GIRL

Joanna Zhou explains the basics of creating an
illustration in a manga style using Photoshop and Painter

Monga artwork often suffers from the unfair stigma of
appearing all the same. Although there are general
stylistic conventions, as we've seen, every artist inferprets these
differently, creating a host of distinctive styles. The more you
draw, the faster you will discover your own style, both in
character design and colouring.

This tutorial guides you through the process of drawing
and colouring a manga picture. The colouring fechnique
outlined here was done in Photoshop and Painter. | also used
a graphics tablet, which is an invaluable tool for anyone
going info digital art. Wacom fablets often come with a free
version of Painter Essentials. Although it's not as good as the
full version, the effects demonstrated in this tutorial can be

recreated (with a bit of practice) in Painter Essentials.

| like to sketch and ink by hand, then scan the outlines
and colour them on the computer. Great care should be taken
over the sketch because it forms the backbone of your work.
Even the best colouring technique won't be able to salvage a
poor, out-of-perspective drawing. When sketching, | check for
mistakes by holding the drawing up to a mirror. Inking is done
in black ink, with a thin fineliner or nib pen.

When working digitally, my files will most likely be in PSD
format to support layers. The final image is then flattened and
saved as a TIFF or JPEG (at least 300dpi). TIFF is better quality
for print, but has bigger file sizes. JPEG has a very small file
size, making it suitable for pictures on the web.
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STYLE CONVENTIONS .

| begin by sketching out the image using a 2B mechanical pencil.
| use a putty rubber because regular erasers can damage the paper
surface and leave dust. A good frick for creating an instant, dynamic
composition is to use a simple pose but draw it with the paper filted.
Some manga guidelines to bear in mind are the conventions for
mouth, eyes and hair. The mouth is kept very small, like a rosebud,
particularly when you're drawing female characters. Eyes are definitely
the number one manga trademark. They should be large and
expressive, with graceful eyebrows and lashes. | like to draw hair as
thick, almost three-dimensional strands: | find it a lot easier fo colour in
later on if | can see where the separate layers of hair begin and end.
Female manga body proportions are usually petite, with skinny
wrists, tiny waists and thin legs; albeit frequently with large breasts!

T

S

-

i e

as SCAN THE IMAGE

The sketch is inked with a thin nib pen and drawing ink. | often vary
the thickness of the lines to create a feeling of depth. For example, the
contrast between the girl's thick outline and the thin cherry blossoms
immediately indicate foreground and background. After inking, I scan
the image at 300dpi and open it in Photoshop to adjust the contrast.
Somelimes it's enough to go to Image>Adjustments>Auto Levels.

1B Addobe Photoshop - [eutline jog @ 5% (Gray/8)]
e G s Layw feet P Vem B beb

# o e

To gain more control, | then select Levels so that | can manually
tweak the contrast. Ideally, you should have a crisp black outline (but
not overly jagged), with no traces of pencil. This is now ready for

|G er RS
PP EA A AN

c0|ouring in.

PRO SEGRETS

COLOURED OUTLINES
Go to the outline layer and change it from Multiply to Normal.
Select all and copy. Then create a new layer right above that and
fill it in with black. Turn this layer into a Quick Mask by clicking
the Quick Mask button on the toolbar. Paste the outlines to get a
red-on-black mask. Remove the Quick Mask and delete the
selection. The outlines are now on a fransparent layer. Select Lock
Transparent Pixels (or Preserve Transparency) and you can now
colour freely into the outlines.
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‘€% OUTLINE WORK

~ The oullines are opened in Painter. | like to copy and paste the outlines
" o a new layer, and set this fo Multiply. This enables me to colour freely
but still retain the black outlines, which show through. | also keep a
completely white layer under the outlines to act as a backdrop.

‘€& COLOURNG

‘K GATHER YOUR TOOLS

Before beginning to paint, | drag my choice
of tools into a custom palette so that
I'll always have them on the screen.
For this project, | chose Digital
Watercolour>Broad Water

Brush, Blenders >Grainy Water,
Airbrushes >Digital Airbrush,

and Gouache >Opaque

Smooth Brush 10,

~ Crrl+ShiftsL (P
Cimdl+ Shifts. (

after watercolourin

| begin by colouring the face using Digital Watercolour. First, | cover
everything with a light skin tone. | then introduce shadows with a
medium skin fone and create some depth with a very dark tone. The
mixer palette in Painter enables you to paint swatches of a chosen
colour so that you always have the right hue at hand.

The shading can be rough and scribbly, as that's where the Blender
Tool comes in handy. Before using it, | have to dry the watercolour
(Layers>Dry Digital Watercolour, or Cirl+Shift+l). Then I take the
Blender and smooth over what I've just drawn to create perfectly

blended shadows.
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‘@& AIRBRUSHING

The rest of the image is coloured in using exactly the same
technique. The Airbrush can be used fo create blush on the
cheeks, add highlights to clothing or correct mistakes.

L]

i

"$& GOUACHE WORK

The Gouache brush is used for zigzag hair highlights, which are
another typical feature of manga illustration. | also like to add single,

G erclPFhall
2 PNES 2PN NIT

wispy strands of hair, in which case | work above the outline layer.

‘€& FINAL POLISH

When the colouring process is complete, | save the file in Painter and

--------

open it again in Photoshop. You can give the illustration a final polish
by using the Hue/Saturation/Colour Balance editers in Photoshop,
colouring the outlines (see the Pro
Secrefs box on p. 46), or resizing
and cropping. Once everything
looks good, Flatten (or Merge
Visible and discard hidden layers).
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ARTIAT DA

Manga mouths are understated yet emotive. When drawing, | try to

emphasise the inner contour separating teeth and lips rather than the

outer lipline. For illustrations, | like to use a colouring process similar
to applying make-up in redl life. First, | render the face and lips in skin tone.
Then | blend in pink tints with a soft translucent brush to mimic lipstick. Finally,
| create a new layer and use a harder-edged brush to dab on highlights.

Manga faces are very flat, so mouths appear almost stuck on. | try to be

quite restrained when shading the lips, so the edges are small. Unless the
character is viewed from an angle, the mouth rarely affects the contours of the
cheeks and nose. Lips are trickier to shade when the mouth is wide open. Trying
fo paint all the way around a large manga mouth will look clownish so 1 often
just give an indication of colour for the bottom lip, or leave it out altogether.

/n ‘JOANNA ZHOU REPLIES

When it comes to painting mouths in the manga

style, less is more: don't try to include every detail.
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ARTIST PROFILE
LOIS VAN BAARLE

counTryY: Holland
WEB: www.loish.net

Lois has been drawing ever since she could first hold a
pencil. She has only developed preference for digital
and animation in the past few years.

BRUSH UP ON YOUR
PORTRAIT SKILLS

“To paint a strong, fashionable female, you need a bright, warm colour
palette and a few decorative elements,” says Lois van Baarle

Femcle portraits have been around forever, showing that,
at the very least, women are enjoyable to paint. In this
tutorial, I'll try fo create a picture that brings out the ladylike
qualities of the subject, using elements like fashion sense,
colour palettes and supplementary figures to make the image
more than just a forward-facing depiction of a girl.

One aspect of making such a piece is to consider how
you'll approach the project concept-wise. Personality plays
a crucial role, and the image should have flair and attitude.
Adding decorative items can give the piece more inferest and

w Manga for Beginners

the character something to interact with, giving you a chance
to play with expression and pose.

The most important technique in this tutorial will be the
painting process. I'll work with a rough, chunky brush and
use prominent, solid brush strokes. Textures will also be used,
helping to create a traditional feel. Intuition will play a key
role; I'll start with a basic concept and see where it takes me.
The final result will be a portrait that, after having undergone
numerous changes and modifications, will convey the
personality and feminine touch I'm aiming for.







Wl MAKE A ROUGH SKETCH ‘€% ADD COLOLRS

When starting your piece, work loosely and don't get hung up on On a separate layer, add your first colours to the sketch. Fill the layer
details. Keep in mind that you don’t have to adhere to every delail in with a dark, deep hue and paint some lighter shades on fop with a
your original sketch; see it more as a starting point. Focus mainly on the chunky brush set to approximately 60 per cent opacity. Starting with a
composition, proportions and pose. I've chosen fo include jellyfish fo dark layer adds volume and a painted feel. The colours can be

give the subject something fo interact with and add a surreal touch. I've changed many times during the process, so just throw some on there
also added thick,loose hair and a number of bracelets to give her a and play around. It helps to decide on one aspect, such as making the
youthful, playful style. jellyfish blue or green, and get the other hues to work with it.
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“§ CREATE TEXTURE

While you're playing around with the colours, add a layer of texture.
Colourful concrete ones are ideal because they have an organic,

~ grainy quality and can have a unifying effect on the shades in your
piece. Add the fexture on a separate layer and play around with the
opacity, hue and layers fo see how they affect your image; I've chosen
Soft Light. The fexture is important because later you'll be picking

~ colours off the canvas with the Eyedropper tool.

Colorice

s

@& MODIFY THE PALETTE

A huge advantage of working digitally is the array of colour-editing
tools you can use fo get a palette you feel good about. In
Image>Adjustments, you can choose from Hue/Saturation, Colour
Balance, Selective Colour and Replace Colour to tweak all or part of
your drawing. | like to use Colour Balance to give an image more
warmth by adding red and yellow. Selective Colour also makes certain

tones pop. Remember the personality you want to convey, and fry to
work towards a pleasing colour combination that achieves this.

Color Leves: [ 0 o

] ovan e D)
Migmnly S — Green
Yelow -3z Bl

Tons Balance
Shadows @ Mdtones Highkghts

¥ Praservg Luminosty
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"€ CHANGE THE HAR COLOLUR

At this point, | feel the blonde hair isn't working. Using the Lasso tool
with a feather of 20 pixels, | make a rough selection of the hair and
use Replace Colour to make the subject brunette. If you feel that you
must change the shade of one part of the image drastically, it's ideal to

do it early on in the drawing process: at this stage you haven’t put in
too much detail, giving you more room to experiment.

3 MERGE THE LAYERS

| prefer to do everything on one layer. When | feel ready to start
painting, | merge all the layers, and then only use them to make
adjustments or add textures, merging these when alterations are
complete. Now I'll begin painting over the line art, rather than under it.

“¥& USE THE EYEDROPPER
TOOL TO SELECT COLOURS

When you start feeling good
about where the image is
going, begin painting in some
detail, Before doing this, make
sure you choose the right
colours by using the Eyedropper
to select the base shade from

AOBENSFANR D)

the canvas. Then manually
select a lighter or darker version
of it from the Colour Window.

3 RN

This keeps the colours unified

and helps you choose hues that

.
LT

enhance your palette, rather
than flat ones that don’t maich
what you've created.
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Start to add some detail with the same chunky brush you were using
earlier. Change the size, opacity and flow based on what works for
you. | like o use anything between 40 and 70 per cent opacity, and
vary the flow according fo the effect | want to achieve. At this stage, try
to sculpt with your paintbrush by adding volume and shape. Don't put
in too many details, and avoid zooming in foo much, so you can focus
on the big picture and have a good overview of the image.

‘& CHANGE THE PALETTE

Getting the right palette is a gradual process. You may have to change
it numerous times until you're happy with the colours you've chosen.
Intuition plays a crucial role: you have to feel good abeut the hues and
get them to suit the aim you had from the outset ~ to make something
fun, feminine and vibrant. Don't be afraid to use the colour-editing tools
or lay down new shades during the process. In this case, affer painting
in some details, | switch to warmer, more earthy options.

“@¥ DISTRIBUTE COLOLRS

The colour combination isn't the only important thing: the way you

distribute it also matters. One way to approach this is to have a calm
base colour with bright accents. I've changed the palette to consist of
cool browns and purples, desaturated blues and accents of orange and
electric blue. To accentuate the fashionable and girly personality of this
character, assign the bright accents to the subject’s accessories and use
the darker hues for her hair and clothing.
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ﬂ' WORK WITH THE BACKGROUND ELEMENTS

What began as a few circular shapes can form the inspiration for new decorative elements in the
background. | feel the circles are doing little for the composition and change them into flowing
forms that lead the eye across the canvas. | also change the canvas size to give these elements
more space. They add a playful and colourful aspect to the piece.

‘& TWEAK FACIAL FEATLIRES

As | add more detail with the paintbrush, | may feel the need to make structural changes to the
facial features. Here, | think the mouth is no longer properly aligned to the rest of her face.
Change these things as soon as you nofice them — it will be harder to do it later on. You can use
Filter>Liquify, or just make a selection and transform it. Paint over any misaligned edges or other

inconsistencies after you're done. Try not to use these methods excessively because it will show.

PRO SEGRETS

USE A HIGH RESOLUTION
Painting at high resolution is crucial to

‘@ PAINT THE HAIR

being a professional digital artist. First

of all, it increases the possibility for
detail enormously. You can work roughly
when zoomed in and still maintain a
detailed and smooth look once you pan
out. Also, having high-resolution versions
of your artwork is absolutely essential
when crealing prints, so the bigger the
better.

'__—-——J
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Something fo keep in mind when adding
more detail to the hair is to draw it in chunks
rather than individual strands. This is what it
does in real life, and remembering that helps
you create more mass, volume and
expression. Try to work out how the different
sections overlap, vary in length and move in
different directions. You'll add more detail
later, so facus on the basic form for now.




‘¥ GET READY FOR PAINTING

At a certain point, you should decide that the piece is ready for refined
painting and details. The canvas and composition should be set, so if
you feel you must make changes to these things, do. In my case,

| finally settle on a warm colour palette with lots of browns and

~ desaturated greens, as well as bright orange, blue and red accents.

¥ SMOOTH THE SKIN

Until now, we've been using chunky and rough brush strokes. Although
this effect is desirable and important for the final work, we can
sirategically smooth out certain aspects of the image, such as the girl's
skin, to enhance her femininity and youth. Change to a smooth, large
brush with a low flow (between one and 10 per cent], and use the
Eyedropper tool to pick shades. Paint gradually over the textured
brushwork with smoother colouring. | prefer not to use the Smudge

tool because it rarely creates a painted effect.
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‘@ ADD CONTRAST AND SHINE

Your colour palette is already set, so you can give the work more
contrast and shine by painting in some highlights and dark areas.
Adding some deep, dark lines fo the pupils and eyelashes or tips of the
hair can make these shapes stand out. Putting highlights on the skin,
jellyfish and decorative forms can also make them shine. Use the
Eyedropper to pick the base colour, then manually choose a lighter or
darker shade. As opposed to the rough painting phase, zoom in a lot
and work in a defailed fashion.

PRO SEGRETS

UNSHARP MASK

Your original artwork exists at a really high resolution, so you'll
eventually have to create a small version for posting on the web.
When shrinking the piece down to a more compact size, you
might notice that some of the detail from the large work becomes
less sharp and defined. Applying the Unsharp Mask filter can
sharpen the image and bring back some of the detail. Keep the

radius small to avoid an overly sharpened look.

“fi& WORK ON FINE DETAILS

IN THE HAIR f"‘&

Because the different chunks of hair have already been painted in, you
can add some strands and shine to the hair, as well as smoothing out
the chunks. It pays fo have defailed and realistic hair in your final
piece, so this part of the process deserves some exira time and effort.
Zoom in and add a bright shine to each individual chunk. Draw strands
that pass over the different chunks for added detail. Turning the canvas
using the Rotate View tool can help you draw the brush strokes in the
same direction as the hair.
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‘L& ADD EMPHASIS
TO THE JELLYFISH

Throughout the painting process, |'ve been gradually adding
more detail fo the jellyfish. Because they're quite central to the
composition, I'll now give them some special attention. After
adding details, you can make them glow. Select the jellyfish

~ using the Magic Wand or Lasso and, on a new layer, fill the

- selection with a bright blue colour. Blur the layer using
Filter>Blur>Gaussian Blur. Then change the Layer mode to Hard
~ Light and adjust the opacity to brighten colour and give the
creatures a vivid glow.

4 ¥ FINISHING TOLICHES

At some point, when enough details have been added and you
feel good about the colours, you're done painting. However,
some finishing touches can be applied to bring the piece
together. On separate layers, you can add gradients or soft
highlights to the picture. Change the Layer mode and opacity to
make these layers blend in to the final picture, In this case, I've
placed an oval shape with blurred edges on a separate layer
and set it to Soft Light at 25 per cent opacity, creating a gentle
highlight in the centre of the image.
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ARTIST PROFILE
CHESTER OCAMPO

cOuNTRY: Philippines
WEB: www.chesterocampo.net
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Chester is a freelance illustrator. He loves Haruki
Murakami novels and conspiracy theories, and is on
a quest to find the best salmon sashimi in Manila.

Creating a cover image is about so much more than just the ch'"
explains Chester Ocampo

N\
Iwus asked to do create a cover image for the ImagineFX A front cover image needs enough negative space o Yok
magazine, and it had to be either an action-oriented or a into account the mastheadifthe ImagineFX logo) and all of th
. wholesome character in a manga style. As you can see, | coverlines. There are also tie colours of these cover elements
ﬁed to choose the more dynamic opfion. | was originally to consider. Because it's a L
asked to paint a double-sized image with the aim of it forming of a manga issue, colourfuligover elements are par for the
a wraparound cover for the magazine, and although the extra course. The trick is not to Iaf he illustration get lost in the

ared usn‘f needed in the end, | decided to stick to the background when placed dginst rhese elemenls Beorlng all
N . this in mind, | set out to cred

“haracter Creutioﬁ“::%‘r;h_
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COMPOSITIONAL BALANCE

Composition is a great challenge when it comes to wraparound
illustrations. For this image, | used a Yin-Yang balance, where the main
point of interest on one side has an equivalent point of interest on the

opposite side. And where one side is sparsely detailed, the other side
is dense, o create a more inferesting visual flow.

STEP-BY-STEP:
HOW | CREATE...A MANGA COVER

‘f GENERATING THUMBNAILS

~ Focusing on composition, | sketch a thumbnail of the wraparound cover. The
~ placement of the character is set to be on the right side of the image, because

* this is the front cover. The thumbnail is drawn at low resolution for speed; the
L

high-resolution version will come later as the illusiration develops.

“&F ROUGH SKETCH

| refine the skeich from the approved thumbnail. Details such as the blades of the
chain-whip, the path of the chains and the placement of the character are finalised.
The character is moved further fo the right so that her head lies on the vertical centre
~ of the front cover for better eye flow, in anficipation of the cover elements.

S 20t

&% LINE ART AND COLOUR FLATS

. Scaling up the image fo high resolution, | then digitally ink the lines. | check the
thinness and thickness of each line, as well as how lines converge on overlapping
objects. Colour flats are then applied on the image. | note their relationship with
each other, and their relationship with the cover elements.
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' How do I give my mangc
charcacters a fun and livel

STEP-BY-STEP: GHNé YOUR
MANGA CHARACTERS A
FUN, DYNAMIC LOOK

“ The sketch on the right is

some of the gesture work that | go 8}* }\ .

through when creating a dynamic N NN
manga character. As | draw these < H 2L
poses, | try to keep the line of action k' 1

(red), and the angle of the hips |
and shoulders in mind (blue), in
orfier to maintain a nice flow.

& Once | decide on a pose, '

| draw out the final line art exactly as

| want it. Again, | want to maintain a
dynamic flow throughout the character.
The red and blue lines mark the spine,
shoulders and hips, while the green colour
marks the lines of action for the limbs.

“ When | finish the drawing, | apply
colour. In this case, | push the fun look of the
character with some vibrant tones. | also like
to look back at animation-style, cel-colour
work, but instead of keeping the shapes very
sharp, | apply a slightly more refined, painterly feel.

Artist Q&A

X VX tones first -

REPLIES

The first thing you need to do is to get
confident with your line and colour. That
comes through practice. Second, start your drawings
by generating pose ideas through thumbnail-size figure
gestures, always remembering to establish a line of
action to give your character a sense of motion. Keep
your line loose and flowing at all times. Third, make use
of suggested lines in your work. You don’t need to draw
every single detail on your character. For example,
when drawing the nose, you only need to develop the
tip and possibly the top end that touches the brow,
avoiding anything in-between. Being deliberate and
strategic with your line placement and flow will keep
your artwork from looking stiff and
\ stale. Finally, when it comes to
‘ adding colour, keep ‘light versus
shadow’ in mind. Don't be afraid to

o 7 get colourful, as this can add to the

liveliness of your piece of art. |
always try to block in my base
in this case, the lights
— and then | go back in and block
in the shadow shapes with a
darker tone. | try fo keep just as
much flow in my brush strokes as
| do in my linework, which in
turn generates a feeling of
unity throughout the artwork.

! MICHAEL CHOMICKI\
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LEFT: In order fo keep things lively, always remember to maintain the
flow of your lines throughout the entire drawing. Simple props, such
as the flying sandal, can really intensify the lively mood.

BELOW: Letting the decisive paint strokes complement the tight,
flowing linework will give your artwork a complete, dynamic feel.

Artist Q&A w
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counTtry: Canada
weB: www.studioqube.com

Michael got serious about drawing at the end of his

high school career, where he became inspired by
Japanese animation and European graphic design. He

graduated in illustration and computer animation, before
beginning work in the videogame industry. He's since
cofounded Studio Qube with his brother Cyprian.

THE GREATEST
WAVERACER

Michael Chomicki shows you how to paint and

colour rubbery fabrics in your character art

In this workshop, I'm going to show you how to create a
manga-esque character illustration. I'll mainly focus on
specific rendering techniques that, while painterly, enable me
to preserve a clean, line art feel.

Throughout the workshop, I'll also study the differentiation
between material types, as well as the relationships between
warm and cool colour tones. I'll look at how fo successfully
make use of shadows, lighting and reflected light, in order to
achieve a three-dimensional form from a flat line drawing.
You should keep the decisive use of dark versus light in mind
throughout the workshop, in order to achieve a shapely, yet
comfortable look to the artwork. Although I'll be working on a
flat, white background, I'll keep a virtual atmosphere in mind,

W Character Creation

and really push bounced lighting. | am going to achieve this
mainly by sharing colours between materials and objects.

Of no lesser importance will be my focus on maintaining a
very Japanese art-inspired look and feel fo the character art.
As a result, I'm going to be very deliberate in how | shape
such areas as the eyes and hair — always distinct points in
manga illustration.

I'm going to keep Japanese animation in mind, specifically
the way that shadows (or ‘cuts’) are shaped. Cuts are used in
animation all over the world, but the Japanese have a very
specific way of shaping them. Since I'm taking a painterly
approach in this workshop, my cuts will be a lot more
painterly than those found in most classical-style animation.






. SCANNING THE LINE ART

o
| start by scanning my line art in at a high resolution, in this case 600dpi. When it's scanned,

| reduce the image fo somewhere between 300 and 400dpi, depending on the size and
purpose of the artwork. | clean up the scanned line work, and remove the white background
space after using Select>Colour Range to highlight it. This will later help me in painting over my

line art. Next, | colourise the line to a desired tone, using Image>Adjustiments>Hue/Saturation.

| continue by importing some solid graphics and logos from lllustrator, and place them in the
artwork (beneath the line art layers), mainly using Edit>Free Transform and Edit>Transform>Warp.
| set the line art layer’s blending mode to Multiply: this will enable me to maintain the line, while |

place all the colour beneath it. | conclude by organising and naming all my layers as something
sensible; whatever | see fit.

1,

‘€ ORGANISE YOUR LAYERS

Once | have all the basics set, | begin creating colour separations for the various sections of the
artwork. For example, | place the skin tones in their own layer, the red of the bodysuit in its own

layer and so on. I'm not foo concerned about achieving colours that are absolutely spot-on at this
stage, as | find that I'l often go back and readijust tonalities later. Most of my colour separations

GROUND COLOU
X (PC and Mac)
shortcut to switching bel

selected foreground and

W Character Creation



“€¥ ADD SOME VOLUME

| start giving the image some volume, mainly through the use of shadow
and reflected lighting. Having assigned all my colour separations to

~ separate layers, |'ve made my workflow for the rest of the painting
process much simpler and cleaner. | select a colour layer, and while
holding Cmd on a Mac, or Cirl on a PC, I click on the thumbnail

within that layer. The Selection Marquee is in my way, so | untick
View>Show>Selection Edges. As | begin fo paint, | use a softer brush
for roughing sections in, and a harder brush for tightening things up.

¢¢ COMPLEMENTARY COLOURS

While picking and choosing my colour tones, I'm always mindful to
push my lighter tones in a relatively warm direction, and my darker
tones and reflected lighting in a cooler direction. This stems directly
from some basic art principles: warm lights should be complemented
by cool shadows, while cool lights should be complemented by warm
shadows. The idea is to push for opposites in tondlities, in order to
achieve a significant level of contrast, and therefore volume.

‘€% DEFINING SHADOW AREAS

| want fo give certain shadowy areas a defined look. | iry to stay away
from working a single area too much. Although it's often very tempting
to just go in and finish off a section, it's always best to work the entire
painting at once. For reflected lighting, | usually fend to choose
tonalities of greys.

Character Creation w
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€& MATERIAL GIRL
Once | feel that I've completed blocking in the shadow areas, | start

adding the lights, as well as some detailing. At this level | also want to
concern myself with the material types that I'm working with, and their
reflective properties. Areas such as the character’s skin will never match
the high specular values of the motor-cyclist’s plastic bodysuit. Since I'm
aiming to give the red a significant amount of gloss, | have fo focus on
high contrast between its values. | achieve this by placing the lights
right alongside the darks. To top off that plasticky look, | use a sharp
brush with a pressure-sensitive fip to add some precise areas of bright
specularity.

[ B
|
|

PRO SEGRETS

LAYERS ARE YOUR FRIEND

Make sure you remember that layers are your friend, and
have countless uses. One of the many ways that | apply the
layer system is in combination with the Eraser Tool. | create
a clean layer and, with my brush, roughly block in an area
of colour. | then take the eraser, with the same seftings as
my brush, and erase into the roughed-in colour, without
having to worry about altering the information below it.
This is just another way of shaping your painting.

‘#& LOVELY RUBBERY «\

For the rubbery areas of the suit, the specular value is much lower than
that of shiny plastic, which means the hot spots tend to be gradual. | no
longer require that high gloss.

W Character Creation



K MANGA FEATLRES

ol BT s i
~ When adding colour o the face, | have fo keep in mind its manga/
~_animé origin. Everything here comes down to a soft look and selective
~ simplification. At this stage, I'm mainly concerned with solidifying a

" comfortable sense of volume. | want to avoid a flat look, although you'll
~ find that, as a result of its simplified nature, a manga/animé face style

~ will tend to look flatter when compared fo other contemporary styles.
L

€& COLOURISING

As | continue detailing the artwork, | make another layer over the top
of the line art layer. It's going fo be in this layer that I'll paint over
and colourise my line. Depending on what | feel is appropriate for
the situation, I'll either freehand some colour over the line art, or
alternatively, | may select all the line in the same way that | do with
the colour separations, and then paint into the selection. This selection
procedure will only work if the white in the background was removed
from the line art layer in the first step. For sections where | want to be
rid of line art completely, | use a layer mask on that layer, which can
be activated by clicking the third icon from the left in the Layers palette.
Following this up by painfing white into the layer mask, I'm then able
to easily hide sections of the line at my convenience, without actually
removing it permanently.




“fF LOOK INTO MY EYES

Since the viewer's eye will always be afiracted to the character’s face
first, | have to make sure to refine it appropriately. This is especially
important to me since I'm frying fo achieve that Japanese look. | paint
over the line art, throw in some gloss on the nose, lips and cheeks, and
pay a lot of attention to the eyes, which, along with the hair, are of
utmost importance.

~* vy

€k HAIR CARE 2

When approaching the hair, | don’t want to be overwhelmed by a A
strand-to-strand approach. | do add some random hair sirands with .
a sharp, pressure-sensifive brush, but fake the maijority of the hair 2
with some solid areas of colour, always making sure to maintain the »
Japanese-style feel. | finish up the hair by adding some animé gloss »

to it. .

PRO SEGRETS

CONVINCING LOGOS

One thing to keep in mind when importing graphics, such as
logos, emblems and designs, into your art, is that they have to
look convincing. One way of achieving this is through the Free
Transform and Warp Tools, in order to distort the desired graphic
over the topology in question. Use the Free Transform Tool to rough
in the placement and perspective, and then the Warp Tool's mesh
transformer to get into those finer, detail areas. Both fools can be
found in the Edit menu.
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“F FINISHING TOUCHES

| finish up the artwork by adding some final colours to the hover ball.
Although | want the tones to remain colourful, | also want to make sure
. that they don’t compete with the colours on the character, but rather
that they recede into the background. In order to wrap it all up, | make
~ any final adjustments fo the areas of the artwork that I'm not quite

~ satisfied with.

- ADJUST BRUSH
~ HARDNESS
Shift+[ or ] (PC and Ma
a brush and press 8!
ecrease brush hardne
Shift+] to increase itf.

Character Creation #



ARTIAT D&A

Latex presents several challenges. It is

flexible, conforming to the shape of the
object it wraps over. There are also different finishes,
from glossy to matt, but it is always smooth. Latex can
be fully opaque or semi-transparent, showing the
colours of the object underneath. I've chosen to render
a type that is flexible, glossy, and semi-transparent.
It may seem challenging to paint all these effects on
a single object, but the pay-off is definitely worth it.
Layers help a great deal here, so Photoshop is my
program of choice. Latex has strong highlights
because of the reflectiveness of the material. Creases
and edges will catch lots of light. As the material is
semi-transparent, feel free to erase some of the base
colour of the latex using a Soft Round brush.

i CHESTER OCAMPO
| REPLIES

0 e e B 2R BN PR U
A e a s a s aaa"s

/STEP-BY-STEP'
PAINTING LATEX AND MAKING IT LOOK REAL...

a, Skefch out your design to start. ﬁ' | recommend that you paint the Q- Underneath this, add a layer filled
Even at this stage, you should be figuring latex on a separate layer. First, block out with white, on a low Opacity and with a
out which type of materials you'll be the parts that you intend to paint as latex. Soft Light blending mode. Some areas of
painting on to which object. Try to prevent Use a Soft Round brush with its Mode the latex clinging tightly to the skin need
separate objects made from the same set to Linear Dodge to render the latex to be erased using a Soft Round Airbrush,
material from overlapping in your material’s highlights. Vary the brush again with varying brush opacities,
composition, so that each object is easy opacity fo suit the intensity of the highlight. depending here on the latex's proximity

for the viewer to distinguish.

to the skin.

7h




seLow: Plan the arrangement
of materials in yourimage

so that similar objects'are
visudlly separated:
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CHESTER OCAMPO

COUNTRY: Philippines
WEB: www.chesterocampo.net

Chester is a freelance digital illustrator who loves Haruki
Murakami novels, videogames, and conspiracy theories,
and is currently on a quest for the best salmon sashimi

in Manila.

Chester Ocampo shows you how to create a manga-inspired,

special effects-laden character image

Femo|e fantasy characters dressed up in outlandish costumes
in an action-orientated image have been a constant source
of inspiration for me. For this workshop I've decided to draw
just that, and hopefully add to your knowledge of presenting
a character that packs a visual punch. Be forewarned that

my methods involve several layers and versions of the same
image, and may present challenges for those with limited
hardware power (like my stalwart, rickety old workstation).

| won't be covering concept generation here, as you probably
already have favourite character types in mind. That said, the
idea for this image is a straightforward one: a female battle
mage casting a spell in preparation for an impending conflict.
This idea can be executed in several ways, by contrasting the
battle mage's arcane spells with modern-day clothing, or a

Character Creation

futuristic battle mage casting spells that look like digital
interfaces. I've decided to go with a manga/videogame
fantasy approach, with the battle mage sporting a spear
that serves as both magic-channelling device and weapon,
and exotic, non culture-specific fantasy clothing.

A few tips worth mentioning before we start: when
working with several layers, it's best to name, group,
and even colour-code your layers for quick referencing.

Save different versions of the image, and save often.
Merge any layers that can be merged to reduce the file size
and avoid having your computer slow down on you. Also,
in case you mess up your current file, you can always go
back to the previous versions and take the parts you need.
Okay, on with the workshop!
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d§ START SMALL,
START STRONG

Image dimensions determine composition, so
| sketch out ideas in the given sizes and see
which size fits the needs of the artwork. For
this workshop, the sizes to choose from are
either single-page porirait or double-page
landscape/portrait. | draw three thumbnails
on scaled-down (25 per cent) versions of the
actual image dimensions. There's no need for
fine details: the main concern is composition
at this early stage. | make sure that the
composition and the subject’s figure have

a nice, smooth flow with the use of curved
lines, contrasting shapes and varied sizes

of elements.

Using a rectangular marquee, | copy the
chosen thumbnail, paste it on to a new file
with the actual image dimensions and
working resolution, and scale it up 1o the
edges of the image. | reduce its Opacity to
30 per cent, create a new layer, then refine
it once the rough sketch is finished. | put a
10mm allowance on all sides to make sure
that none of the important parts of the image
get cropped out during printing. It's easier to

crop an image than fo add extensions onto it.
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€ FINE LINES

:-,'reduce the Opacity of the skeich layer to 30 per cent. | create new layers for ink lines, inking
certain areas such as the face in a separate layer so that it won't get messed up when the areas
Qﬁnounding it get inked. | use the regular Hard Round brush, with Size Jitter set to Pen Pressure
for varying line weights, and the Eraser Tool to knock out overlapping or unwanted lines. | turn off
the visibility of the rough sketch layer once inking is finished. | refine the line art by zooming in
~and erasing or redrawing some lines, then merge all the ink lines under one layer of line art.

Y

MERGE LAYERS
Cirl+E (PC)
Cmd+E (Mac)
s selected layers tog
entire group of
a single layer

‘¥ DIVIDE AND COLOLR FLAT

Underneath the line art layer, | create a colour flat layer that covers all
the elements conveyed by the line art. This omnibus colour flat layer
serves as a fail-safe in case some elements are not properly given flat
colours. | use a combination of the Wand and Lasso Tools to select
elements that are not next to each other, and fill each with a flat
colour. Each layer of colour flats should have a different hue for

easy distinction. | group the line art and colour flats together by
selecting the layers and pressing Cirl+G.
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¥ HOUSE OF FLOATING TILES

Elements not included in the inking process, but that play a significant
part in the composition, are fleshed out at this point. In this image, the
battle mage has several tiles floating around her spear and flying all )
over the place. All files are of the same design, so it pays fo create a
master copy. From this, | make duplicates and Free Transform (Ctrl+T)
each file fo its proper perspective, referencing the layout from the rough -
sketch. | position the files on the foreground and background, above
and below the character group respectively, and keep the files in
separate groups.

“f§ CAST SOME MAGIC RUNES

The magic runes emanating from the mage’s
spear are another imporiant element not

included in the inking process. | make a new
file and create a spiral vector path with the
Pen Tool, selecting Paths in the top toolbar
before | start drawing the shape. | select

the Horizontal Type Tool, double<lick on the
spiml to create a fext cursor, and type ofong

the path using an arcane font. Now | Cirl-
click on the fext layer in the Layers palette to
select the text outlines. In the Paths palefte,
| click Make Work Path from Selection: this
converts the type to a shape, so | can apply

Free Transform on the magic runes later.

| make two rasterised copies of the magic
runes, applying Filter>Blur>Gaussian Blur on
one and Filter>Blur>Radial Blur on the other.

| group the rune layers and drag the group to
the main image. | Free Transform the runes
based on the sketch layout. | create the
feathers on separate layers, using a regular
Soft Round brush.

Character Creation




PRO SEGRETS

DETERMINING LIGHT SOURCES

When applying multiple light sources on an image, it is highly
recommended to work one light source at a time to maintain the
consistency of each lighting effect, and to avoid confusing one

with the other. Work from the weakest light source to the strongest.

If the strongest lighting is rendered ahead of the other lights,
there’s a danger of neglecting the other light sources altogether,
making the forms look flatter than they would have if proper
multiple lighting had been executed.

4@ PICKING LOCAL
COLOUR

With the composition locked down, | go back
to the colour flats of the subject and start
choosing local colours for her costume and
weapon using the Lasso/Magic Wand-and-fill
method, or painting over with a Hard Round
brush. Using a Soft Round airbrush, | paint
the background colours. These background
colours may be dark and muted, but the hues
shift from cool to warm, hinting at a sense of
movement. The colours harboured in the
background will play a huge part in lighting
up the character and other objects later on,
so I'm careful to choose them well.

‘€ PREPARE FOR LIGHTING

| save a copy of the image, then flatten the line art and flat colours
group info a single layer, leaving the group of floating tiles in their
respective single layers. | duplicate the background colours layer, bring
it to the top of the layer stack, and set the blending mode to Multiply.
The entire image has darkened, making it ripe for rendering lighting
effects. There's a faint light coming from above (let's call it skylight) and
a warm light (firelight) from the bottom right. The battle mage’s spear
has its own lighting effect emanating from the crystal mounted at the
tip. It's good to vary the intensity of each light source for a more
interesting result. | assign the faint purple skylight as the weakest, the
warm orange firelight as a moderate, and the magical blueish light as

Character Creation W
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& SKYLIGHT :

| copy the background tiles, subject and foreground tiles layers into
one group: | bring this to the top of the layer stack, lock each layer’s
transparent pixels and fill each layer with black, then set the group
blending mode to Linear Dodge. | make two more copies of this group,
for a total of three groups set to Linear Dodge: the fop group is for
rendering light from the magic light source; the next group is for
firelight; and the bottom of the three is for skylight. Keeping the lighting
layers in different groups is handy for adjusting the intensity of each
light source later on. | render the skylight first, which is a faint blueish-
purple light coming directly from above. | pick the colour from the top
part of the background colours layer (the one with the Normal blending
mode, not Multiply). | render the lighting on each layer inside the
skylight group, using a semi-Soft Round brush with noise, as it gives a

hint of faint brush strokes and a bit of texture at the same time.

Character Creation

SHORTCUTS

PHOTOSHOP

—
BRUSH TIP SHAPE
Hardness: 50 per cent
Spacing: 25 per cent
SHAPE DYNAMICS
Size Jitter: O per cent set to

Pen Pressure

0¥ FIRELIGHT

Next up is the firelight lighting group. As with the skylight, | pick
the warm orange colour from the bottomright corner of the original
background colours layer, and proceed to render the lighting on

each layer of the firelight.

Minimum Diameter: 70 per cent

CUSTOM BRUSH
Painting brush
OTHER DYNAMICS ]
Opacity Jitter: O per cent sef
Pen Pressure

Flow Jitter: O per cent set to
Pen Pressure
Noise: On
Airbrush: On
Smoothing: On




A MAGIC LIGHT ;

Lastly, | render the magic light by determining its source, the crystal

at the tip of the spear, as the point from where the pale blue light
radiates. The magic light is quite close to the subject, and it will only hit
areas directly exposed to it. Affer defermining the intensity of the magic
light as it affects the subject, its effect on the background can now be
created. Using the Lasso Tool, | create a star-burst shape, with its focal
point the magic crystal near the tip of the spear. | feather the selection
to 50 pixels and, using the Radial Gradient Tool and a pale blve
colour, create a gradient from the focal point outwards. The basic

lighting render for the entire image is complete.

A& UP-CLOSE RENDERING

| combine the skylight, firelight, and magic light layers with each of

their corresponding flat colour layers. (Skylight subject, firelight subject,
magic light subject, and flat colour subject layers should be all merged
together.) | set each lighting layer’s blending mode to Linear Dodge.
Once the lighting layers have been combined with their corresponding
flat layers, the image should be ready for fine rendering. | zoom in on
detail-intensive areas such as the weapon, face, and body, and blend
the colours using a smaller size brush. | check how the elements interact
in terms of lighting and apply the necessary bounce light by picking the
colour of the reflective element and painting it lightly on the reflecting
element. | paint over the line art, picking the surrounding colours.

Character Creation #
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& MAGIC PARTICLES

Using a regular Hard Round brush, but with tweaked scattering and
spacing seftings, | create the particles of magic on layers underneath
and above the subject layer. | create a pale blue outer glow for the
special effects layers using Layer Effects. | make another special effects
layer that follows the path of the runes, using the Scattered Dots brush.
| apply an outer glow layer effect on this as well. | make another layer
just above the background layer and doodle in concentric circles with
the scattered dots. | use Radial Blur to create a burst effect, lock the
transparent pixels, and use radial gradients to fill it with colour.

PRO SEGRETS

LOCK UP THOSE PIXELS

A layer's fransparent pixels can be locked in such a way that
brush strokes will be limited to a layer’s contents and not go past
them. Alternatively, using a selection that has dotted lines may be
a bit distracting while painting. But there is a way to work around
this. Ctrl+H will hide the dotted lines but still keep the selection.
Locking a layer’s transparent pixels is particularly useful in keeping

the edges of the image elements clean and sharp.

i DEPTH AND FOCUS

Since the layers are kept separate throughout the entire process, a
depth of field effect can be applied using varied levels of Gaussian
Blur. The battle mage and her weapon are the focus, while all elements
in the foreground and background are blurred relative to their distance
from the focus. Objects nearest to and furthest from the viewer are
blurred the most, with other objects blurred less as they approach the
focus. Using a feathered Lasso Tool, | select any specific areas that
require blurring. The magic runes, for example, stretch out from
foreground to background, so only the central area should be left

free of blurring.




‘63 THE FINAL TOUCH-UPS

Before continuing, | save the current version of the image as a copy
and flatten everything. Now | can zoom in and touch up the parts that
need further definition or correction, safe in the knowledge that | have
a back-up if things go wrong.

‘3 COLOLR TREATMENT

This step can be conducted as early as the lighting stage, but it's
usually easier to just do this during the last stages, so | don't get
distracted by too many options too soon during the work process. Cool
colours usually recede when placed next to warm colours. With this
image's focal point being dominantly blue, | increase the saturation of
the blue and slightly desaturate the warm areas, but do so carefully to
retain some of the colours established during the painting stage. |
create a new layer with blending mode on Overlay, filling that layer

with a low-saturation warm colour, then apply a pale blue radial
gradient from the magic crystal
outward to the far ends of the
image. | use adjustment layers
to tweak brightness and
contrast and use some selective
colour [blue). Lastly, | create a
new layer, fill it with black,
apply a Noise filter on it, set
blending mode to Overlay,

and turn Opacity to 10 per
cent. This will create a subtle
grain texture fo the image, so
that it doesn't look too pristine.
And there you have it: the
finished image.

\ f:\ , T
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How can | make two

big mechs colliding
feel more powerful2

seLow: Render highlights and shadows based on
the light sources. For finishing touches, use
adjustment layers on top of the entire image to
tweak the colour balance and conirast.

p

S

CHESTER OCAMPO
REPLIES

It's always fun to see two objects collide at high
speed, and fo paint the point of impact. I'm going
to paint robots colliding, in the middle of a battle. They're
always fun to draw because you can make them do just about
anything and not worry about whether or not it's based on
hard science. In my opinion, they rank as one of the most
fantastic character types you can draw from in science-fiction
and fantasy, along with wizards and dliens. The first thing to
do is fo conceptualise how you want two robots going head to
head to look. Make a list of inferesting things that only robots
can do or interesting attributes that only robots possess. Some
cool things that come to mind are energy projections, machine
parts, glowing bits, and, best of all, guilt-free violence. With
robots, you can have them
fighting as viciously as you
want and still manage fo
appeal to the squeamish.
Their battle could reach
crazy levels of violence
without showing blood and
gore. Alfter you've made
the list, choose which of
those interesting elements
you want to highlight.
Giving them all equal
emphasis makes
everything compete for
attention and will leave
the entire image looking
fiat as a whole. So it's

best to prioritise just a
single element, and show
smatterings of the rest.
Here's one way to
compose this scene,

using Photoshop.
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STEP-BY-STEP: HOW TO FPAINT THE POINT OF IMPACT...

.20y
ﬁ-’ Begin by sketching. Lay out all the elements you want to see in the
final image, and make sure the interesting stuff is included in the sketch.
Choose one element, like energy projection, and emphasise it over other

elements. This gives the image a clearer focal point.

gy
-y v
’ - Once you've finished the line art, add flat colours and a basic
background. With flat colours, create several decals in different colours
as accents to large flat areas of the robots’ armour plating. We're starfing

to feel like these metallic monsters are pounding on each other

a-’: Now you can add special effects, like energy blasts, sparks,
glows and light streaks on separate layers. Looking at it now, the energy
blast is the sirongest light source in the enfire image, and will largely
determine the highlights and shadows as you get painting.

\
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Hoang works in the game industry, contributing to well-
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THE PAINTED

PRINCESS

Create a unique style using proven techniques in Photoshop,
as Hoang Nguyen demonstrates his angle on the floating world...

Most artists will search a lifetime for their own style and
identity. Some have a unique look that sets them apart
earlier on; others might take a while. But what is important is
that the artist’s artistic vision stays uncompromised and true to
their drive. I'm a firm believer in growing and learning as an
artist, and even an amateur can teach a professional a thing
or two. In this workshop, I'll explain how to draw and direct
viewers into your own world. I'll focus on using simple
composition and design to capture that fleeting moment. This
is my take on Japanese ukiyo-e, a print-making and painting
technique that goes back centuries and was made famous by
artists like Hokusai and Hiroshige.

HIE oo e

| like to start by focusing on creating a simplified back-
ground, so that it doesn’t overwhelm the main theme, but
helps to keep the focal point and lift it off the page. Then
I'll explore how to create a colour scheme to complement
the subject. Lastly, I'll define the light source to help fie up
all the elements.

It's @ portrait — but not in a traditional sense. | like fo
set up my composition with themes that | like to paint. And
since the theme of this workshop is the ukiyo-e style, it's right
up my alley. I'm a big fan of old Japanese art, especially
Hokusai, so I'm going to be bringing together something
old and new.







¥ composITION

As the subject matter is the ukiyo-e style, I'm going to try and mimic
those Japanese paintings, but with a modern twist to make it a bit more
interesting. Ukiyo-e was a kind of woodblock painting depicting the
“floating world’ ~ a world of luxury and privilege, unattainable to the
common man. | like to keep my composition simple and not centre on
the image, so | focus most of my attention on the face and direct the
viewer's aftention to the main focal point. My other point of interest is
her tattoo, so | spend time on that too. Now that I've established that,
my aftention will be on the subject, and everything else is just
background.

FINAL COMPOSITE

TEXTURE LAYER

BROWN LAYER

V00 PENCIL LAYER

o ol o
€3 MAKING A BACKGROUND

I'm"forid, &f bamBoo forests! THere'is & calmness that.has always drawn
me to them, and I'd like to capture that in this workshop. | start with

just a pencil and paper, using a vellum Bristol board (because of the
smoothness). | focus on blocking. in the bamboo, always irying to
keep.it simple. Once I'm happy with the result, | scan it in at 300dpi
greyscale. I'll convert it to RGB mode when | start painting. It's currently
a bit busy, but once all the layers are composited, I'll simplify it even
more, Now. | start out with some colour testing. I'm more concerned
with big shapes and colour rather than worrying about details. In this
image I'm going for a cooler colour palette, and trying fo keep it
almost monochromatic. This was made using textures and clone tools.

| add some noise using Despeckle (it's under Filter>Noise>Despeckle).
This gives the image that old textured look. It somelimes creates a moiré
pattern, so you might want to be careful of that.

w Manga Style




€% THE FINISHED BACKGROLIND

Now that I've got all the necessary layers done, | start experimenting. The pencil layer is at
40 per cent Opacity, with the blending mode set as Linear Burn. The brown layer is set at
75 per cent Opacity, using Overlay as the blending mode. The blue fexture layer is at

100 per cent Opacity, again using Overlay. To composite the finished background, each
layer is applied in chronological order to achieve the final look. Texture gives the image
more depth and it helps to weather the look a bit.

“K¥ FACE DETALS

Now that | have the background in place,
I'm going to focus on her face. | start out
with simple black and white hues and apply
shapes. | usually like to paint in layers, so
that | can just delete it if I'm not happy with
how it turns out. | play with the hair,
experimenting with various brush sizes and
opacily. | also block in the face and define
some shapes and forms. At this stage, I keep
everything prelfty flat and simple. | think
abeut where the light source is coming from,
and start to give the form some light and
shadow.

L

€% EYES, FACE AND SKIN

| want to put more emphasis on the eyes and face to draw the viewer in. The eyes hold so much
emotion that you can tell if someone is happy or sad just by looking at them. | start by applying
skin colour over the B&W layer, and add deail
around the iris and her eyelashes, Using just the

regular brush and setting my brush size between
410 10 pixels, | detail in her face. | also play
around with values and shadows to define form
around her facial features.

Manga Style v




‘& THE HAIR AND LIGHT & KIMONO DETALS |
| put more details into the hair and start fo focus a bit more attention on W g
how the light bounces off her. At this point, I'm pretty happy with her | start out with the pencil line work. Notice that | have the bamboo F,
face, so | move on for now. I'll add more details, like light and layer showing through: this is to help me with positioning the Es
shadows, once I'm near the end. background art. Now | have started to paint in the form and shape
using only greyscale. This helps me to determine how | want the ;0

composition to turn out.

€& ADDING COLOURS

I'm going with a more desaturated colour palette, so | do some testing with the blue fint, I'm
thinking of having her body blend into the background, with the primary focus on her face. Here
I'm testing various elements, combining the blue layer and the warm layer to achieve the look I'm
after. | like how it's turning out at this stage and will move on to the fatfoos. I'll be adding more
details to the kimono in the final stages.




more details and colour around her shoulder. | paint some warm colour to help the tattoo settle
-~ on to the skin.

lll | \*
& \ \\\\

f/l’
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“f¥ BLUE WORK ¥ COMBINING ELEMENTS

| start experimenting with a blue hue, overlaying it on top of the fattoo. - At this stage, I'm ready to

| fest the skin colour fo see how the fattoo works with the other combine various elements and
elements. Notice that her shoulder is blending into the background, start fo finalise the painting. | drop
which is what | was planning. | make some minor touch-ups and move the background in and mask

onto the next stage. 3 around the figure. | then paint in

the light source and try to soften
her look a bit. I'm getting close to
finalising the painting ~ | just need
to combine the foreground and

background.

A& WORKING THE SKIN

| build up layers of skin tone and add a variety of hues ~ mostly purples
and blues - beneath the skin layer. This process is very important in
building up realistic skin shades, since it will give more depth and form.
As light bounces off the skin surfaces, certain elements will be lighter
than others. Areas under the eyes, around her eyelids, and the breast
region are very thin and will reflect light and shadow more. Using a
much warmer palelte, | experiment with a few different colour schemes.
| actually like this look, but feel that the impact is not strong enough.
Because | want all the attention to go toward her face, the warm colour

choice might not work.



‘¥ FINAL DETALS

| go back to the cooler scheme: it seems best for the image, since it'll
help to make her face stand out. | start to focus more on her face,
adding highlights and mascara. The background and foreground blend
rather nicely. At this stage, I'm very close to finishing the painting. | just
need fo go in and add the final details. On a different Multiply layer,

| apply more make-up around her eyes. Using a muted olive green,

| apply @ thin layer over and around her eyelids. I'm also softening
around her eyes so that it's less intense, and add highlights fo reflect
the light source coming from the left.

¥ FINISHING IT ALL OFF

. | paint in some birth marks and moles to give her more realistic skin.
These flaws help to define who we are, and are quite attractive.

| also add some handwritten text to marry the images together,

The background blends nicely with the characters, making it look
somewhat worn down. Lastly, | add a Kanji layer and make my final
pass, and it’s all finished.

Manga Style W



PAINTER

SHE DREAMS

OF LILAC

Joanna Zhou shows you how to create an atmospheric
manga painting without relying on outlines

One of the greatest challenges of painting is being able to
produce realistic contours using only colour and shade.
Manga style is poorly suited to this style of painting, since
details are always rendered as inked outlines first.

We tend to think of colouring in a manga drawing rather
than painting one. This tutorial introduces an unusual manga
technique which involves painting directly on top of the
sketch. It's a great way to experiment with lighting, colour
combinations and atmosphere, and | thoroughly recommend
that you try it. Working without outlines also encourages you
to loosen up your style, and trains you fo exercise control over
the fluidity of a painted surface.

This is an ideal crossover technique for manga artists

A e
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JOANNA ZHOU

COUNTRY: UK
CLIENTS: Animexx eV, Raptor Publishing
WEB: www.chocolatepixels.com

Joanna is a freelance illustrator and graphic designer.
She has 10 years' experience drawing manga with
professional exposure in the UK, USA, Austria and
Germany. She is also a member of the well-known UK
manga group Sweatdrop Studios.

wishing to venture into realistic fantasy painting, or vice versa.
Bear in mind that manga characters are stylistically quite
different from real humans, so standard painting conventions
need to be treated with discretion. The distorted facial features
mean that the T-zone across the eyes and down the nose and
mouth need to be treated with particular attention. A manga
face is quite flat so you can’t make features meld with the
bone structure as you would on a real face.

The key is to keep shading nice and subtle, and carefully
layer on shadow until you have your desired result. Of course,
this image is still quite comic-like, but you are free to tweak
your own style between manga and realism fo create
something truly unique to you.






A8 STOP THE WHITE WASH

With a painterly technique in mind, | pay close attention fo the interplay
of light and shade when skefching. | try to visualise the final image
without any outlines, and block in appropriate areas of shade. | scan
the sketch and set it to a Muliply layer.

A good trick when attempting a dramatic or experimental piece is
to fill the background in with a different colour. Working off a white
background will almost always force you into a rut of using predictable
shades. | test a few skin tones against the pale blue, and settle for
complementary lilacs and dusty pinks. | don't think | would ever have
picked these tones if | had been working off white.

\
F
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€ IN THE MIX

Using the skefch as a guide, | begin blocking out areas of colour in
my picture with the Smeary Round Qil brush. As usual, | keep distinct
areas on different layers for easy editing. For this fechnique, it's very
important to make use of the Mixer. This is a palette where you paint
tiny swatches of all the colours you've used in case you want them
again. [pick a colour up with the Eyedropper Tool). The Mixer is also
useful in controlling the overall colour scheme of your image: you can
see at a glance how many shades are going on, and whether or not
they complement each other.

"W W W ¥ W W W W W W W W e = ®



€3 REDUCE OPACITY K SHARP CONTRASTS

My basic colouring style here is fo block in shades with the Oil brush As more details begin to emerge, | face the challenge of creating crisp
then smooth it with the Blender Tool. The key objective is to wean edges without using outlines. The best way fo simulate depth is to have
myself off the reference sketch, so | constantly reduce Opacity as a sharp contrast of dark (object behind) and light (object in front]. You
the shading builds up. Eventually, | turn off the sketch altogether could even go a step further and really “lift” up an object by edging it
and continue to work only with the colours on my painting layer. with a colour that contrasts in hue and fone (such as the yellow hair
The Blender Tool is amazing for subtle gradation, but should be used highlight shown here). Try to build up all areas of the painting at an
with care: it can muddy up your shades if applied too liberally. equal pace, with an equal level of complexity. This ensures that your

final piece will be coherent, and that all the colours and shapes work
well with each other.

Cirl+[ or ]
Cmd+[ OR ]




€ HEAD DETALS 3 STRANDS OF HAIR -

I make a new Multiply layer and use the Digital Airbrush to paint on The Blender Tool is useful for defining strands of hair: set at the right
cheek blush. The Multiply setting means that any shading I've done width, it creates a sharp edge with the adjacent colour. For the flyaway
below will show through and the tint appears realistic. For the hair, strands | colour over them thickly, turn on the sketch, and use the eraser
| use the Opaque Smooth Gouache brush to flick out pale, wispy to remove any excess. .
strands. This has the effect of creating more depth in the picture. Finally, | paint in a dark cloudy sky to give the scene a litfle more »
| decide to refrain from using solid black: it would create much drama and add a sparkle trail with the Fairy Dust F-X brush. Symbol »
deeper shadows than | want for the colour scheme of this image. brushes should be used sparingly, though: they can quickly overwhelm
a picture. T
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When you're trying to show a story,

sometimes it's hard to choose what to draw.
In fact, drawing manga is similar to shooting a movie or
making an animation: you have to choose the right thing
to draw in order to show the continuance of the story.
In manga, it's even harder because you need to pick
only a few frames out of the whole scene to convey
the story. But the way to connect them is pretty similar.
For example, if you have a person who's looking at
something in the panel, try to think about what the
reader would expect to see in the next panel. I'd assume
that the readers are curious about what the person is
looking at. So in the next panel, | draw the object or
view of what they are looking at, but not the person with
the object or the view. Then, in the next panel, maybe
you want fo show something specific, such as the size
or distance of the object. In story writing, | often follow
the writing structure ‘start, support, transition, closing’.
This is the way of keeping the flow of the story going

MICHAEL CHANG
n |'I'ING YU REPLIES

smoothly. | use this writing structure as reference fo draw
manga. For example, you might start with a person who
is looking at something. In the next panel, you show the
reader what that person is looking at. Then maybe in the
next panel you can show more supporting detail, such
as the size of the object. Then for closing, you show the
reaction of the person after they saw the object. If's not
a real ‘closing’ if it's in the middle of the story: it's just

a stopping point for readers fo go on or simply just a
transition. Now you've built up the atmosphere that
attracts the readers to go on to the next page.
Sometimes you want to show impact in the story. Then
you choose to have a big panel. But what should you do
before that? | usually make the panel before the big one
smaller, and draw something minor in it. For example,
say | want to show a huge group of bees in a big panel.
The panel before this would be just some small dots
coming from far away. When readers get to the big
panel, the huge group of bees will really stand out.

ABovE: With manga, you have fo tell an entire story in just a few frames, so
it's important to think carefully about all of your panels.

107




MARKER PENS

MISTRESS OF
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Aileen is a freelance illustrator and comic artist who
focuses mainly on manga art. She ventures into digital
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THE ELEMENTS

Aileen Strauch shows how you can work with marker pens to create
an action-packed manga image in iridescent and vivid colours

You can create slick and clean looking illustrations of

all sorts when you know your way around marker pens.
It might take some time to get used to a few of their habits,
but the results can look quite impressive for a tool branded
as traditional media.

This tutorial will solely focus on colouring a manga-style
image with marker pens. | will show how they can be used
while going through each stage of the image, from first sketch
to the last stroke of colour. One thing | cannot stress enough is
the fact that there is no Undo button for any mistakes: once
the colour is on the paper, it stays where it is with little or no
chance of correction. This might sound a bit harsh, yet with

Manga Style

some planning you can prevent most major disasters, like
bad colour combinations, from happening.

Most of the time | get inspiration for my artwork from
unexpected sources, but browsing for something specific
can yield its surprises too. When | am fixed on a specific
idea, | usually start to sketch a variety of poses and related
things until | am looking at the right version. It also helps to
think of a background story or what kind of personality a
character has. | often like to include little things which define
a character’s traits, and it makes the time working on an
image much more exciting. It can even spawn its own little
comic idea.






¥ sHADOW
AND LIGHT

Before | start to draw the outlines on to
marker paper, | make a quick copy of the
rough sketch to get an idea about the light
sources in the image. | tend to use garish
colours for this step, but it helps as a quick
reference later on when adding shadows and
i coloured reflections. Any planning done now
will save you lots of time and redraws later.
There's no Undo button here — how exciting!

ﬁa COLOUR SKETCH

A second and equally useful preparation is a
colour sketch that contains the main colours
for the picture. Picking colours for minor
details is not important at this point, but it
gives a good idea of whether the main
colours work together. Sometimes | have a
certain colour scheme in my head, but it
doesn’t work as well on paper. | try different

combinations until | am satisfied.

€F LINES

For the outlines, | use a mechanical pencil not thicker than 0.5 mm, and 0.35mm for smaller
details. It's easy to draw clean and smooth lines with them. I then trace them with different
coloured fineiners that are marker proof. This is crucial: some types of fine-liners can bleed
when they come in contact with markers and will resultin weird smudges.

As a precaution | only trace a line once with the fineliner, leaving out any dynamics of the
outlines, because of a marker’s ability to pick up dark colours.

After finishing the coloured outlines, | carefully remove the pencil lines with a smooth eraser.
It won't be possible any more once the colour is on if.

. % & 5. 6.6 60 .00 6.8 .0.8_0._

W LIGHT RELECTIONS

The first step of the colouring process is the blue light reflections that are cast by her magic.

L ]

It also adds a nice touch of contrast to the overall sunset colour scheme. In general, the colours
of marker pens are transparent and mix when another colour is added on top, which is why
| add the blue with the fine nib first.



Here the brush nib comes in really handy, and enables me to create
-~ slight gradients from the skin colour to the white of the paper.

DARKEN THE SKIN

~ It's easy to build up the colour with markers on a few layers. With two
~ shades slightly darker than the base skin colour, | add depth and some
~ defined shadows, taking into account the reference | created earlier.
 With the brush nib, | add the darker colour which blends into the base
- of the skin colour.

‘6 SHADOWS AND CONTRAST

Finally, I put an even darker skin tone on top, which gives the defined shadows more shape.
| like to apply a contrasting colour: one of my favourites is a greyish lilac. | add it to some of the
darkest parts of existing shadows. Skin tones in general work well with cold colours as shadows.
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¥ FOLDS AND FUR

Defining folds on the clothes is an act of
spontaneily, since | don't plan every single
fold of the fabric in advance. It looks
unnatural if they're all shown as part of the
overall outlines. | put several layers on fop
of each other to model a decent amount of
fold in her cape, indicating a thinner fabric.
The skirt contains a second layer of the
base colour and brown colours on top. |
add more attraction to the white part of her
undergarment with the light turquoise that |
used on her skin in step 7. Lastly, the fur gets
a different treatment. | enhance the look of
the fur by using single dols. | place them

" according to the shadows in a variety of
colours, some of which pick up elements of
the cape’s colour.

‘€ PATTERNS

Patterns without outlines can look as
interesting as those with, but because there
are already a lot of details on her corset and
the image, | decide not to use any bordering
lines for the small pattern. | recommend
drawing the pattern on a separate sheet,
even though it is fairly simple. Because
marker paper is very thin, | put it underneath
the image so that the pattern shows through. |
use the colours according to the shapes but |
am careful that the colours do not overlap.

€& MORE COLOURS

Now | add the flat colours of her clothes. It is
the first time | discard the brush nib and use
the thin nib instead. When | colour a large
area like the cape, | have fo work rather
quickly in order to prevent an overlapping

of the same colour or visible strokes. This

happens when wet colour layers over an
already dried part: it can spoil the effect of
an evenly coloured area. Small circular
strokes with the thin nib are very effective at
preventing this.




- iy

q@ DETAILS

Now that most parts of the character have
received colour freatment, | start to focus on
the defails. It takes up some time, but can
enhance the picture’s atmosphere immensely.
The wand is supposed to be made of some
kind of metal, so | apply bold lines with a
dark greyish lilac after the soft gradients of
shadows. Her boots get a freatment of a top
coat using a neatly applied light blue, while |
colour the skulls more roughly.

W DOING MAGIC

Finally | can add the visible parts of the magic as blue sparks: the
essence of the evoked spirit. | simply add blue in irregular lines and
bubbles with the help of different blue shades. | start with the lightest
tone, then apply more tone but less colour with each darker shade. %,

& eves

In contrast fo the colour sketch, | change one
of her two eye colours. | replace the green
with red because | want a pop-up effect
together with the blue eye. Even though the
sclera is white, it needs some soft and

defined shadows to work together with the
shading of the rest of the face. Afterwards,

222}
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| create the darker parts of the iris with the
same colour as the base colour.

HIE oo s



" ﬁ» THE STONE BODY

With the base colour, | leave the space for
the blue spirit particles intact. Following this
step | add an orange colour
to a few parts of the body
in order to reflect the colour
of the sky. Turquoise suits
the faint reflection of the
blue from the light particles.
Afterwards | create different
cracks and partial shadows

with various cold grey tones
to emphasise the

rock-like feel. A bit of light
yellow on the head of the
giant functions as a visually
more pleasing fransition
between the stone and sky.
Once | finish these steps,

| apply bold shadows with
a dark cold grey on top of
the other layers.

g oo SEJE



¢ cLOUDS IN THE SKY

Before | started with the colouring process, | intended to use a stylised cloudy sunset, which | will
add now. First I'm going to colour the sky, while | leave the clouds blank for the moment. Sketched
clouds on a separate piece of paper underneath the picture provide a good guide for where fo
place the colour for the sky. Dark colours are trickier fo blend because more shades are needed,
but the colours themselves can be used as blenders. This is exactly what | om doing with the
gradient from orange to violet.

While the orange is still wet, | carefully apply the lilac to blend the colour with strokes in only
one direction = no wild or irregular movements. Marker colour tends to dry very quickly, so | work
on one part at a time.After | finish the different tones of the sky, | turn my attention fo the clouds.
| wet the area with a blender and create a smooth flow from beige fo the paper’s white. A
blender is a marker without any colour: it makes blending techniques like the wet-in-wet method a
lot easier. | don't let the beige dry, and | apply some yellows and faint violets onto the clouds to
add more movement and character.

Last but not least, | add colour to the flying rock islands with slight shadows.

¥ BLACK AND WHITE

The only things left are the finishing additions of dynamic outlines, white highlights and colour
splatters. | use the fine liners to give the outlines varied thicknesses; a white gel pen helps with
highlights. Additionally, | create white and black spatters with a small metallic screen and a
Bristol brush. F

A scanned picture without adjusted colours can quickly look flat and
lacking in colour. Always take time to properly scan the image and set
the colours right by readjusting the scanner’s preset seftings as a first
step. Colours can then be individually changed in software

such as Photoshop.

w Manga Style



EMMA VIECELI
REPLIES
The inking stage holds huge importance in

black and white manga images. The finish
of your inks will dictate the finish of the image, so do
take time over width variation and making ends nice
and sharp. Even if lines aren’t going to be obviously
visible by the end of the image, they'll act as a
framework for your fills. Because of that, it's good to
start any manga image by completing the line art fully.
Start with the largest area of solid black, which will
guide you through the rest of the image. This step is
especially important if black is to be your surrounding
base colour. Sometimes, an effective tip is to leave a
white ‘halo’ between your lines and the solid fill. The
trick, then, is simply to fill in further areas of the image
with two things in mind. First is balance: try to avoid
all of your blacks being bunched up in one place and
vice versa. Make sure that black and white are nicely
balanced. Second is proximity: should you need to
put two areas of black next to each other, add a white
divider. (Ideally, however, no two black fills should sit
directly next to each other
in the image.)

FAR LEFT: When you only have two
tones to play with, it can be hard
to plan exactly what will work, so
have fun experimenting.

LeFT: I¥'s good practice to start with
fully finished line art.
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PHOTOSHOP

FLIGHT OF THE
WARRIORS

Sinad Jaruartjanapat explains the techniques used to develop Japanese style
characters, from line art right through to colouring and shading

Most people are aware of the differences between

typical manga illustrations and western art styles.

You probably know what makes each style look good, too -

but have you ever wondered why manga artwork often

appears simple, but still manages to convey lots of detail?

To understand this style, we need to get right back to basics.
We'll start by looking at layout and composition, and how

they’re connected to the story you want fo fell. As you'll see,

line art isn’t just used as a guide for painting in manga

illustrations — it's an essential part of the finished image.

HIE v s
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ARTIST PROFILE
SINAD JARUARTJANAPAT

| country: Thailand
WEB: www.sinad.cgsociety.org

Sinad is a 30-year-old illustrator from Bangkok who
paints both male and female manga art in Photoshop.

Use of colour is also important. It may look simple, but
as you'll see, appearances can be deceiving - it’s not just
about what you can see with your eyes! In this tutorial you'll
also learn the importance of colour theory, and find out '
about different ways of using colour that are exclusive to
the Japanese manga style.

This is how | go about drawing and painting manga
artwork, from the initial sketch to the line art, to the
colouring. I'll give you an insight into the techniques | think
are most important for creating Japanese-style illustrations.






-
-
* &
& & o . s =
@ & & & & & & & » »
& ® & &8 5 5 & " & »
& & & % & " 8 s 5 @
® & & & » » & 8 & »
® & % & % 5 & 8 8 @
® ® & % & & & % » »
® ® % & & 8 8 8 8 &
& % & & % » 8 8 s »
y S 9 & & & & 8 8 8 @
- & % & 9 % 0 @ o2 »
: b s & & & & 8 & 8 8 @
"X @ & ® % 9 ® o ® &
. ® & % & & & & & & =
-.m....-. 2 / @ & & & % o 5 ® & =
e - a W W W W _ W W W _w_w_w_w ® % & & % 2 % @ 0 =
S ST 0 308000 0000000080856 66668050 =
= = oW oM o o N o W oW k4 2 8 &8 8 8 8 8 8 & @
" = LS S8 & . k8 : >
L e B & 5 B a0
L ®E K N N I
£ Do
 gi= O »
- 4 & s
L =
i 4 f A M
X 4 s

L

HooM M
P
E N W w
.

L

-
-~
(O

o=

e :
- . %

i w ] i 3
W B YT N 2

i - B " B -
- = = = W N N | A WL W W W W Y P T T Y T Y P R ey 9T ST e @
* 4 ¥ N NN X | =) 2 8 8 * &
W oW oW oW oW oM oW W oW M ...Q. I..ll.ll..o.o.tto.tiot_-l.to.ouo S hh aca
BB ES S S !.!l 2 (E M oM A M M E E R E NN NN RN
= - M om oW | . £ O 0 0 8 5 ® & 0 & 8 8 8 8 5 8 8 »
*« % N X N M N 88 8 4§ 5 8858550888086 8 8 5 5 s &

® m M = m oW ow ow w W W oW w W = (. D .9 5 9 P & & ® & & & 0 5 0 8 » & &

.




PREFARE TO ADD COLOUR

- Before | start colouring, | usually make a selection for each character

~ (Select>Save Selection) and save it so | can moke adjustments later on.
- These selections make it easier to work on an image, and are

- particularly helpful for painting manga illustrations, because this style

~ needs clearly defined areas of colour. While selections are useful, don’t
~ use too many or it won't look natural. For this image, I've only created
~ selections for the two main characters’ outlines and skin. | colour the

~ other areas by hand.

| Destruton R |
| conmene | 1o e ¥ .'_m__l.\m 2l
| vt BT

‘¥ USE DIFFERENT HUES TO
CREATE SHADE

| use colour to control the overall feeling of an image. | like to blend

"
. colours with either the nearest or the opposite hue on the colour wheel
to create a feeling of depth. | think this is a better fechnique than using

-
-
L
" bright and dark tones of the same colour to create shadows. This

>

colour-blending technique is very popular in Japanese illustration.




€% CHOOSE YOUR CHARACTER COLOURS .

I've added colour fills to my characters to make them jump out of the background as if they were
part of a collage. Colour fills help create harmony in the image and provide depth for characters
and objects. | erase some colour from the character so the colour fill appears. The amount | need
to erase depends on how much | want the character to blend with the background. | might use
this technique to blend a character into the background or to make another stand out.

A& HAR IS LIFE

When I'm colouring hair, | always iry to create an impression of volume. | don’t draw individual
strands = | just try fo give the impression that the hair is waving in a certain direction. This is a
key part of the manga style. Have a look at any Japanese manga comic or cartoon for examples

O{fhis. S




€} GET RID OF THE
LUNNECESSARY DETAIL

Trying to paint realistic detail in this style is forbidden - seriously! The
main parts of this character’s face are her eyes and cute mouth, so |
only paint the area between the eyes and eyebrows, and the T-zone.
This is enough to draw attention to the eyes and mouth and show that
this is a person’s face. Don’t add more detail than you need to,
because doing so will spoil the image.

A g\,{i N 7%

K& PAINTING SKIN

While I'm painting the character’s skin, | make sure | check some

reference pictures. There are two parts fo this step, the first of which
involves creating a sense of volume. Once I'm satisfied with the shape
and lighting, it's time to move on fo the second part...

Cmd+U (Mac)
Cirl+U (PC)

Manga Style w




¥ ADJUST THE SHADING

At this point, | look at the image as a whole and decide if | need to
adjust any shading. | often add a litfle more colour to areas that need it
to create a sense of depth. Another technique | like is adding a little of
the background colour to parts of the skin that are in shadow. This
should come from the opposite direction to the main light source. |
apply these techniques on separate layers so | can adjust them later.

“@¥ LET THE LINE ART SHINE

| focus on refining the shadows and making sure they're large enough
to create an impression of volume.l don't worry too much about the
smaller details, such as the girls’ accessories - the line art will give
these depth. In my opinion, too much shading in a tiny space can make
the image look heavy.

w Manga Style
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4} NO COMPETITION

Now it's time to paint the second girl. | use slightly brighter colours
to make her blend into the background, because | dont want her to
* compete with the foreground character. Anyone looking at the picture

should see the front girl first.

s PR
‘& CREATE DEPTH
Now |'ve got all the detail | need, it's time to create depth by erasing

some colour from the main character. This is the same technique | used
to add a litlle background colour to the shaded areas. :

the selected ¢

@ FINAL ADJUSTMENTS

It's hard to decide what | need to adjust in the final step fo make the = S
image look exactly the way | want. I've been working on the painting 1
for a while, which can make me too familiar with it, so | Iry to get it out

of my sight. When | return to it later, | can see what needs adjusting.
This is the same technique | used with the initial sketch.

Manga Style #



When drawing chibis, | always make sure

the body stays between one and three head
heights tall. Guidelines are indispensable, since it's
easy to subconsciously drift away from such
compressed proportions. | feel that the purpose of the
chibi style is to create an emotional connection with the
viewer, so | fend to put most effort into attaining the
right facial expression and body language. unemotive
details such as wrists, ankles and feet often get
streamlined in the process. If something doesn’t look as
cute as it could be, I'll try moving the eyes further apart
or the mouth higher up, shortening the eyebrows or
erasing the nose. | also love incorporating cute design
details such as ruffles, bows, hearts or flowers. This
gets extended into a pastel rainbow colour scheme with
lots of shiny bits!

JOANNA KHOU
REPLIES

;_“‘ S Te

3 = | start with a rough sketch of the head and body

prdpb‘riions, shown here in red. The head is a virtually perfect

sphere: | simply dip the outline at the front inwards slightly to create
a facial profile. | only begin adding details once I'm completely
happy with the body language and dynamics of the image.




Focs
| like to vary the line widths quite a lot when inking
because this makes line art visually stimulating, which in turn
reflects the emotional state of a chibi picture. It helps make them
cuter to look at. When drawing more than one character, | also
avoid giving any two the same facial expression, for variety.

}* Chibi illustrations are fun and bubbly, so | love using @
brighl' palette. Pastel shades, rosy cheeks, shine and sparkle also
enhance the cuteness of the image. Black outlines often appear
slightly harsh in this context, so I've coloured them in to create a
sense of 3D. For a twist, you can put cute chibis in a scary sefting.
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WORKSHOPS ARTIST PROFILE

MADELEINE ROSCA

COUNTRY: Australia
we: www.clockwork?7.mangafolio.com

Madeleine is a freelance illustrator, and has created
three volumes of the popular manga series Hollow
Fields. She’s currently working on a new series.

PHOTOSHOP

THE MUSIC OF
LIFE AND DEATH

A bright and eye-catching manga illustration isn’t so difficult to create
once you know the techniques. Madeleine Rosca is your guide

aving worked in manga illustration for several years now, stand out, I've created a style that combines my inferest in both.
I've learned a thing or two about colouring my images in Its bright, snappy and draws the viewer’s eye towards the work,
Photoshop. | love coming up with cool character designs, but using a couple of Photoshop’s more basic tools to achieve some
sometimes the plain white background behind them just doesn't gorgeous tonal and compositional effects. And I'm going to
cut it, so I've gradually started incorporating decorative designs show you exactly how to do it in the following workshop. For
into my backgrounds. I've always loved bright colours and rich, this demonstration, I'll be using Photoshop CS3, as well as my
intertwined art nouveau-style borders so, to help my artwork trusty litfle Wacom Intuos 3 tablet.

Manga Style







ﬁ SKETCHING

"€ STRENGTHENING THE LINE ART

THE THUMBNAIL

| start by drawing a thumbnail
sketch of the image, which helps
me decide on the characters’ poses
and the position of the contents in
the background. I'll keep referring
to this throughout the process.

ﬂt« INKING THE MUSICIANS

Following my thumbnail sketch carefully, | produce an ink drawing of »
the foreground characters, which | then scan in. | like to make sure my
il drawings are relatively large, so that there’s a good amount of detail ir :
e "} B the finished product when I print them and they're considerably smaller. :

: il | scan in the drawing at 600dpi, then reduce that to 300dpi to work
with. Even for a cover image, 300dpi looks just fine and prints well, b
| wouldn't recommend going any lower. It's always better to have more
resolution than you need, rather than less. 2

R R T T L Tary - |

E -

With the line art on screen, | start to prepare it for colour. In order fo

get the lines looking clean and strong, | choose Image>Adjustments>
Levels. The White and Black Sliders at either end of the Levels graph

are the most important: | slide them close together, somewhere around
the 200-210 mark. This not only makes my drawing sharper and

bolder, but cuts out any grey pixels that were created during the
scanning process. Getting the line art reduced down to just black

and white values is crucial for the next step — the all-important

alpha channel. L i o i

w Manga Style
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¥ CREATING AN ALPHA CHANNEL FOR LINE ART

Using an alpha channel in Photoshop enables me to select the line art
by itself with no background around it. This means I'll be able to add
colour to the lines themselves, instead of having fo refain black lines,
which gives my picture a sense of depth and sofiness. | prefer this
method to many of the other common ways of colouring line art.
Crealing an alpha channel for the line art is simple. | choose Select>All
to select the whole picture, then press Ctrl/Cmd+C to copy it. The
Channels polette should be found in the same window as the Layers
palette: | open it and select New Channel from the drop-down menu.
Now | have a new channel called ‘Alpha 1. With that channel
selected, | press Cirl/Cmd+V to paste. | select my Layers menu once
again and create a new layer, giving it the title ‘Line Art". Clicking
Select>Load Selection in the menu bar, | use the drop-down Channel
menu to select ‘Alpha 1’ and tick the Invert box. My layer now has a
selection of all the line art, with no background selected. All | need to
do here is to make sure my foreground colour is black, then go to
Edit>Fill.

: 1

Load Selection ] T

Source P . |
Document: manganouveaula.psd -

Channet Lineart Transparency |5d]
Lineart Transparency

Operation *&
@ New Selection

=pipiNPAN MR/
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€% FLAT COLOURS

Now comes the most time-consuming part of

Layers x | Channets | Paths - "'l\
Y
Norma » Opacity: 100% * / '\qc_g)

A 0" WP L
the exercise — putting in the flats. The Hat mcacd | 4 -

colours determine the overall colour scheme i I:I nandt fore
of my picture, plus they come in handy for ® (v @ wav
making selections. Using a hard brush at »
100 per cent Opacity, and changing the

size depending on my needs, | get to work

on this process. »

3 ORGANISING LAYERS

I'm placing many of the different elements in this picture on to separate
layers to further help me with selection. | usually organise them by
character, so the names of the layers are ‘character A's skin’, ‘character
B's dress’, and so on. With this many layers, it's impertant to organise
them into groups so that | don't get lost in my Layers menu and spend

five minutes hunting for one liftle blob of colour on a particular layer!

“#& THE IMPORTANCE OF
BACKGROUND COLOUR

Unless you intend to end up with a picture featuring a figure

]

surrounded by a blank expanse of white, never colour againsl . =
a white backdrop: this often makes it much harder to drop in‘@
background later on. It's better to colour against a pale, faidy = =

neutral hue — which I've put on the lowest layer here., o

w Manga Style g
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€ CREATING HIGHLIGHTS
AND SHADOWS

With the flat colours neatly organised underneath my line art, | can
now start the process of adding highlights and shadows fo the image,
which really begins to bring out the forms and shapes of the characters.
This is a fairly simply process. For this | tend to use the Magic Wand

to select the contents of a particular layer, then hide the Selection
Marquee by unticking View>Show>Selection Edges. Choosing a
suitable darker hue of the base colour, | begin adding shadows with a
soft brush, usually at 30 per cent Opacity or less, blending the colours.
| apply a similar technique when | add highlights, using a lighter hue.

"€ THE LITTLE THINGS

For some particular effects, such as wrinkles in clothing or highlights in
hair, | use the Smudge Tool. Using a small, soft brush at about 90 per
cent Strength, | carefully drag out small details and smudge them into
the shapes and effects | want. Reducing the Sirength of the Smudge
Tool enables you to create more sublle effects, but also makes it harder
to control, so you might want to experiment and find a setting that gives

you a decent trade-off between these